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Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Objectives Reporting for 2018

PROMOTING INTEROPERABILITY STAGE 3 FOR
MEDICAID EPS IN 2018 - INTRODUCTION

This guide (formerly titled Meaningful Use Stage 3) contains scenario-based examples of the
workflow needed to become compliant for Promoting Interoperability Stage 3 measures. Some
of the most common scenarios are outlined here, although the methods presented may not
always be the only way to complete a given task.

Note: In 2018, all providers must attest to objectives using EHR technology certified for
the 2015 edition, or for a certified combination of the 2015 and 2014 edition (provided the
mix of certified technologies does not prohibit the EP’s ability to meet Stage 3 measures).
Eligible Professionals (EPs) using technology that is certified for the 2014 Edition only may
not attest to Stage 3 but can attest to Modified Stage 2.

IMPORTANT! Version 11 of eClinicalWorks is the 2015 certified technology.

The recommended methods of satisfying Promoting Interoperability measures are detailed in
this guide, but there may be other methods of satisfying certain measures using the
eClinicalWorks EMR/PM system. For more information on all features available when using
eClinicalWorks, refer to the HelpHub, which can be accessed from within the eClinicalWorks
application at: Help > HelpHub.

IMPORTANT! There are two types of objectives: percentage-based and self-attest. Self-
attest measures require users to meet the criteria and report with a Yes or No, while
percentage-based measures require calculations to determine the numerator and
denominator. The MAQ Dashboard is a reporting tool that can be used to determine how
well you are satisfying the percentage-based Promoting Interoperability measures with
eClinicalWorks.

Objectives Reporting for 2018

All providers are required to attest to a single set of objectives and measures. This replaces the
core and menu objectives structure of previous stages.

For EPs there are eight (8) objectives, including one consolidated public health reporting
objective.

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 7



Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Excluding Visit Types from Promoting Interoperability

Certain Visit Types, Visit Statuses, and patients are excluded from all Promoting Interoperability
calculations. For more information on the processes related to excluding visits, statuses, and
patients, refer to the following sections:

m  Excluding Visit Types from Promoting Interoperability Calculations

m  Excluding Visit Statuses from Promoting Interoperability Calculations

Note: Visit Type and Visit Status exclusions affect only the eight objectives. They do NOT
exclude for Clinical Quality Measures.

Note: All Medicaid EPs, regardless of past participation, must attest for 90 consecutive
days in the calendar year: January 1, 2018 to December 31, 2018.

Excluding Visit Types from Promoting Interoperability
Calculations

Certain visit types can be automatically excluded from Promoting Interoperability calculations.
Any visits with these visit types are ignored by the system when calculating compliance
percentages for all measures.

Note: These exclusions apply only to objective measures, not CQMs.

IMPORTANT! Visit types should not be excluded from reporting if they are used by any
providers for face-to-face encounters.

To exclude visit types from Promoting Interoperability calculations:
1. From the Admin band in the left navigation pane, click Admin.
The Admin login window opens.
2. Enter your administrator password and click Login.
The Admin window opens.
3. Click the User Admin folder in the left pane.
The items in the User Admin folder display in the left pane.
4. Click Visit Type Codes in the left pane.
The Visit Type Codes options display in the right pane.
5. Click Add.
The Visit Codes options display in the right pane.

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018



Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Excluding Visit Types from Promoting Interoperability

6. Check the Exclude from Meaningful Use Reporting box:
Visit Codes

Hame
[ranmy|

Description

Chart Title

Color

Pick Color... f|
Visit Type

|Regular Visit x| Custorize..

Visit Type Duration(in Mins)

[” OBGYM History [ PhysicalTherapy

3 Requires Claim W Requires Copay
| Pregnancy Visit [ vision Visit

[ orthopaedic Visit

[” care Plan visit [T Care Mgm Visit
[ worksheet visit [ CCMR visit

[ Referral Required

{* fctive (7 lnactive |

[V Exclude from Meaningful Use Reporting|

[T Donot dizsplay Appointments with this visit type in 'Progress Notes' visits Drop Down
[~ Synchronize this visit type to patient portal

[T Medication reconciliation not NECESSAry. L2

7. Enter any remaining information here as appropriate.
8. Click Save.

This new Visit Type is created. Any encounter using this Visit Type is not included in the
calculations for any Promoting Interoperability measure.

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 9



Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Excluding Visit Statuses from Promoting

Excluding Visit Statuses from Promoting Interoperability
Calculations

Certain visit statuses can be automatically excluded from Promoting Interoperability
calculations. Any visits with these visit statuses are ignored by the system when calculating
compliance percentages for all measures.

To exclude visit statuses from Promoting Interoperability calculations:

1.

From the Admin band in the left navigation pane, click Admin.

The Admin login window opens.

Enter your administrator password and click Login.

The Admin window opens.

Click the User Admin folder in the left pane.

The items in the User Admin folder display in the left pane.
Click Visit Status Codes in the left pane.

The Visit Status Codes options display in the right pane.
Click Add.

The Visit Codes options display in the right pane.

Check the Exclude from Meaningful Use Reporting box:

o Visik Status Details
Code Status Calor

L [MUExclusion Pick Color.. |

{* pillable " Hon Billable
F Exclude from Meaningful Use Rﬂpurﬁml
I Trigger Demographic Mandatory Field Check

Enter the rest of the information here as appropriate.
Click Save.

This new Visit Status is created. Any encounter using this Visit Status is not included in the
calculations for any Promoting Interoperability measure.

Requesting a Direct Address

A Direct Address is required for practices to electronically transmit clinical information to a third
party. This is one of two options that satisfy aspects of Objective 7: Health Information
Exchange (HIE) (formerly Objective 5), and can also optionally be used for Objective 5: Patient
Electronic Access (PEA) (formerly Objective 8).

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 10



Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Requesting a Direct Address

To request a Direct Address:

1. From the Admin band, click eCW P2P Admin:

Adrnin |

ﬁl!

Settings

F 1 9
Resources
+_@

User Logs

Order Set Co

[1]]
1\

eCW P2P Admi...

The P2P Admin window opens.
2. If you are already on Join the Network (JTN), click Edit Settings:

i Promider Rageiraton () FECETy Regsyaion

Provider Hams E-mail (1] Jip Code

O & Wills Sam i oo 1033412739 33437345 Edil Brof

If you are not yet on JTN, click Register to Join the Network.

The P2P Account Settings window opens.

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 11



Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Requesting a Direct Address

3. In the HISP - Direct section, click Option 2:

HISP - Direct
wliralorts £ e Ligabiod W dord o Friete S el Saund Reisaie. Finate el $in P cotes el -
el Rk Mt s Bt [Dplios 10
Reopdatale b 0 fetiherd Bl masl b3 el iy il B B wnptedetars (bl are med 8 peart of the Do 1] rurs aselle "V oo a0 i B Pt i (0! e Bt Soh de fedendis’ peat 03

o orde plivmahiviri o weuld i sk I gence,

# el il ek Dol Plor {Spbios 1

Thin mosied sl for frie e 1 et B HEGP venedors (Rl are part of Soonodibnd et T st buondle | rieaca ks v elirsalinnt LUE an EHUAS ETAAR mo ol imd S0 Bt i fart o Srrit Tt burcle b flinte fbeate sty
et [ 3T PESRY, i g iekma o abeiat el UM el mes SnETTAL BOD

G o e ol G200, Pt (o i il Lrnder =, R0l T . L0 I i D (s,

oy

Npmzie Capck At n‘l—mn-
) - Evllt.lﬂf ﬂlm r"hFl.l i ———

[ T [ L ]
Wyl g deia Fa TR Pl ey A o B it el P
et mind et ki B Y et A B T B bl A a4 B ] il v el s EaCals el Bt il ral alb e anltaio i

Gt Tl DN aellraina regpetid by

4. Enter the name of the organization for this provider in the Your organization name field.
5. Enter an abbreviation for the organization in the Abbreviation for your organization field.

Note: Do not include special characters or spaces in this field.

6. Click Check Availability:

Sample Direct Address:

{Znnhdﬁmiﬁddrﬁs:
ke ,”I.'j‘_  testprovider@gmail com
First Name: S5am-300penMSSOL Last Hame: Willis
Your organization name: 000 hhhreﬂam:;ram olely)

Address avadable.

Ok Avaiabiy_

If the address is available, a green Address available message displays:

Sample Direct Address: 53
Contact Email Addrﬁx_:

AN OISO B

frpct reclest i be gd

First Name: Sam-300penMSSOL Last Hame: Willis

Your organization name: 000 Ahhmmx:uh;m olaly

Check Availability
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Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Requesting a Direct Address

7. Click Submit:

Sample Direct Address: §3
Contact Email Address:

e Howig hra)

TR e testprovideri@gmail.com

P T ey c - i i
et e ol do B

=

First Name: Sam-300penMSSCL Last Hame: Willis
Your organization name: 000 Ahhmhx:;ram alely)
Addreis avaiable.

There is no cost to participate in eCW HISP for MU 2 attestation purpose.

Enterprise customers who may need us to help them with the request process, will have onboarding cost
(%60 per provider annual cost to set up direct address and maitbox)

Terms and Conditions :

The ‘frae s mned” madbsl e by el B
5 e ITEE OF COSR MG 15 N 1§

s Ranswal Process: Usere can remew their cer

Out-of-Nebtwork Exchange:

The request for this Direct Address is submitted.
8. Complete this request for each provider that requires a Direct Address.
9. Open a support case with eClinicalWorks to initiate the project.

Note: The direct address has a Pending status and updates to an Approved status only
after ID proofing is completed by Digicert® and the certificates are uploaded.

HISP-HISP connection is established through eClinicalDirect HISP, which is part of the Direct
Trust Bundle.

eClinicalDirect is fully accredited by EHNAC and is part of the Direct Trust Bundle.
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Promoting Interoperability Stage 3 for Medicaid EPs in 2018 - Introduction Requesting a Direct Address

Creating a Support Case on the Customer Portal for Direct
Address

Path: Create New Case > Service Request > Services > Interface > Direct Messaging/HISP connection
Create a Support Case in the my.eclinicalworks.com Customer Portal:

m Reason: Option 2 Direct Addresses Needed

m  Message: Requesting Direct Address for Option 2 for ## providers. Direct Addresses
requested in their P2P settings with Organization Abbreviation <<Enter Abbreviation>>.

m Additional Details: Enter any additional details for this case.

eClinicalWorks will assign a Sales resource to this project.

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 14



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 1: Protect Electronic Protected Health

PROMOTING INTEROPERABILITY STAGE 3
OBJECTIVES FOR MEDICAID EPS IN 2018

The following objectives are related to Promoting Interoperability Stage 3:
m  Objective 1: Protect Electronic Protected Health Information (ePHI)

m  Objective 2: Electronic Prescribing (eRx)

m  Objective 3: Clinical Decision Support (CDS)

m  Objective 4: Computerized Provider Order Entry (CPOE)

m  Objective 5: Patient Electronic Access (PEA)

m  Objective 6: Coordination of Care Through Patient Engagement (CCTPE)
m  Objective 7: Health Information Exchange (HIE)

m  Objective 8: Public Health & Clinical Data Registry Reporting (PHCDRR)

Objective 1: Protect Electronic Protected Health Information
(ePHI)

Objective

Protect electronic protected health information (ePHI) created or maintained by the Certified
EHR Technology through the implementation of appropriate technical, administrative, and
physical safeguards.

The following sections are related to objective 1:

m Protect Electronic Health Information Measure

m  HIPAA Security Risk Analysis (SRA) for Promoting Interoperability
m Features Relating to Protecting Electronic Health Information

m Protect Electronic Health Information Auditing

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 15



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 1: Protect Electronic Protected Health

Protect Electronic Health Information Measure

Measure

Conduct or review a security risk analysis in accordance with the requirements under 45 CFR
164.308(a) (1), including addressing the encryption/security of data stored in CEHRT in
accordance with requirements under 45 CFR 164.312 (a)(2)(iv) and 45 CFR 164.306(d)(3), and
implement security updates as necessary and correct identified security deficiencies as part of
the provider's risk management process for EPs.

IMPORTANT! No denominator/numerator calculations are required for this measure. This
measure is reported through self-attestation.

Note: Regardless of whether a practice is locally hosted or hosted in the cloud, a Security
Risk Assessment must be conducted by each practice at least once every year.

HIPAA Security Risk Analysis (SRA) for Promoting Interoperability

As part of the Health Information Technology for Economic and Clinical Health Act (HITECH),
eligible providers of healthcare who are preparing to attest to Promoting Interoperability of
technology are required to include the Protect Patient Health Information objective, which
addresses the HIPAA requirement to conduct an annual security risk analysis (SRA).

The Protect Patient Health Information objective requires each practice to conduct an SRA or
review/update a previously completed SRA, implement security updates as necessary, and
correct identified security deficiencies. Unfortunately, many practices have never performed an
SRA, or are not performing an SRA on an annual basis.

Protection of the privacy and security of patient data in the EHR under HIPAA/HITECH involves
more than attesting to the internal security features of the EHR that are provided by
eClinicalWorks. The HIPAA Security Rule is wide-ranging and encompasses such areas as:

m Business Associate Oversight

m Business Continuity | data backup and disaster recovery

m Data Security | ePHI storage, transmission, and disposal

m Information Security | risk management, incident detection, and incident response

m  Network Analysis | architecture, access control, device management, and event
management

m Personnel Security | hiring processes, security awareness, and security training
m  Physical Security | practice facilities, environmental concerns, data center

m  Systems Analysis | system hardening, upgrades and patches, firewalls, anti-virus, intrusion
detection, authentication

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 16



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 1: Protect Electronic Protected Health

While protected health information (PHI) is protected by the many security features that are
integrated within the eClinicalWorks comprehensive EMR/PM system, full compliance with the
Protect Patient Health Information objective requires a thorough security risk analysis that
covers a full spectrum of security concerns as listed above.

To help you conduct a risk analysis that is right for your medical practice, OCR has issued a
Guidance on Risk Analysis. ONC worked with OCR to create a Security Risk Assessment (SRA)
Tool to guide healthcare providers (from small practices) through the risk assessment process.
More information on the HIPAA Security Rule can be found at http://www.hhs.gov/ocr/privacy/
hipaa/administrative/securityrule/.

To assist our clients with performing a security risk analysis in support of Promoting
Interoperability Protect Patient Health Information objective, eClinicalWorks has identified
several products in the marketplace and has developed business relationships with four
vendors that offer a variety of tools, services, and price points for performing an SRA that will
be comprehensive and auditable:

m  The Compliancy Group
m  MedTech USA/HIPAAAudit.com
m  GSG Compliance

m ecfirst

The Compliancy Group

Product: Designed by auditors and privacy/security officers, web-based, easy-to-use, logical
interface designed to work with you and your organization through collection, audit,
remediation, training, and tracking.

The Guard Sentry: Best for practices of 10 or fewer providers and three sites.

The Guard Sentinel: Best for practices of more than 10 providers and more than threesites.
Contact Information:

Tel: 888-854-4722 (855 85 HIPAA)

www.compliancy-group.com/ecw

MedTech USA/HIPAAAudit.com

Product: Web-based download contains policies and checklists for Risk Analysis, including Risk
Management, Sanction Policy, and Information System Activity Review.

HIPAAAudit.com: Appropriate for practices of all sizes.
Contact Information:

www.MedTechUSA.com/ecw

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 17



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 1: Protect Electronic Protected Health

GSG Compliance

Product: GSG Compliance will help put your practice in the best defendable position, give you
the confidence to answer any audit questions, attest for Promoting Interoperability, and give
you a baseline on your HIPAA Privacy & Security.

SRA: Appropriate for all practice sizes.
Contact Information:

Tel: 887-270-8306
info@gsgcompliance.com

Bill Steuer - bsteuer@gagcompliance.com

Todd Greenburg - tgreenburg@gagcompliance.com

ecfirst

Product: Tailored consulting, training, and certification services, specializing in cybersecurity risk
assessment, vulnerability assessment, penetration testing and managed security.

bizSHIELD™: Appropriate for practices of all sizes.

Contact Information:

Karen Durbin

Tel: 515-444-1221

karen.durbin@ecfirst.com

www.ecfirst.com

Features Relating to Protecting Electronic Health Information

The following features are available to assist in protecting electronic health information:

Feature Area to Document within eClinicalWorks

Security Attributes Access this feature from one of the following locations:
m  Executable: File > Security Settings

m  Browser: Main Menu > eCW Menu > File > Security
Settings

Rx Security Admin band > Admin Logs icon

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 18
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Objective 1: Protect Electronic Protected Health

Feature

Area to Document within eClinicalWorks

P.S.A.C.

Access this feature from one of the following locations:

Executable: File > Security Settings > Rx Security

Browser: Main Menu > eCW Menu > File > Security
Settings > Rx Security

Confidential Progress Notes

Access this feature from one of the following locations:

Executable: File > P.S.A.C. Settings > New

Browser: Main Menu > eCW Menu > File > P.S.A.C.
Settings > New

Executable: File > P.S.A.C. Settings > select group name >
assign members > Save

Browser: Main Menu > eCW Menu > File > P.S.A.C.
Settings > select group name > assign members > Save
Executable: File > P.S.A.C. Settings > select group name >
Advanced Settings

Browser: Main Menu > eCW Menu > File > P.S.A.C.
Settings > select group name > Advanced Settings

Confidential Patient
Accounts

Progress Notes > Visit Code > Confidential Note

Authentication Settings

Patient Information > P.S.A.C.

Admin Logs

Access this feature from one of the following locations:

Executable: File > Settings > Authentication Settings

Browser: Main Menu > eCW Menu > File > Settings >
Authentication Settings

measure.

Users Guide on the HelpHub.

Note: These are some of the common features related to protecting electronic health
information, but may not represent a comprehensive list of features available to meet this

For more information on how to use these features, refer to the System Administration

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018

Using Security Settings

m Executable: File > Security Settings

Browser: Main Menu > eCW Menu > File > Security Settings

Chaiet bracch  Baledd e Frar With S Mull)

Reviewing Administrative Logs

m  Admin band > Admin Logs icon
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| | |
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Using Rx Security

m  Executable: File > Security Settings > Rx Security

Obijective 1: Protect Electronic Protected Health

Browser: Main Menu > eCW Menu > File > Security Settings > Rx Security

Patiert Schedule EMRE Bfing e cecunity SELTGS
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018

Using P.S.A.C.

m Executable: File > P.S.A.C. Settings > New

Obijective 1: Protect Electronic Protected Health

Browser: Main Menu > eCW Menu > File > P.S.A.C. Settings > New
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m Executable: File > P.S.A.C. Settings > select group name > assign members > Save

Obijective 1: Protect Electronic Protected Health

Browser: Main Menu > eCW Menu > File > P.S.A.C. Settings > select group name > assign members >

Save
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Obijective 1: Protect Electronic Protected Health

m Executable: File > P.S.A.C. Settings > select group name > Advanced Settings

Browser: Main Menu > eCW Menu > File > P.S.A.C. Settings > select group name > Advanced Settings
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Making Patient Accounts Confidential

m Patient Information > P.S.A.C.

Obijective 1: Protect Electronic Protected Health
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Setting Up Authentication Settings

Executable: File > Settings > Authentication Settings

Objective 1: Protect Electronic Protected Health

Browser: Main Menu > eCW Menu > File > Settings > Authentication Settings
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Protect Electronic Health Information Auditing

For this measure, you will need to provide documentation to CMS proving that you completed a
security risk analysis (SRA). When you perform your SRA, you should have a checklist of things
to complete for it. Keep all relevant documentation records (paper or electronic) used for
completing this security checklist. Failure to keep or provide a copy of records during an audit
could result in a failed audit.

Security attributes, Rx security, P.S.A.C. categories and permissions, authentication settings,
admin logs, confidential Progress Notes, and confidential patient accounts are available from
eClinicalWorks to satisfy this measure. For more information on how to use these features,
refer to the System Administration Users Guide or the HelpHub.

Note: Regardless of whether a practice is locally hosted or hosted in the cloud, a Security
Risk Assessment must be conducted by the practice.
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Objective 2: Electronic Prescribing (eRx)

Objective

Generate and transmit permissible prescriptions electronically (eRx).
The following sections are related to objective 2:

m  Electronic Prescribing (eRx) Measure

m Electronic Prescribing Denominator Criteria

m Electronic Prescribing Numerator Criteria

m Electronic Prescribing Exclusion Criteria

m Features Related to Electronic Prescribing

Electronic Prescribing (eRx) Measure

Measure

More than 60 percent of all permissible prescriptions, or all prescriptions, written by the EP are
queried for a drug formulary and transmitted electronically using CEHRT.

Note: Rx eligibility must be verified prior to e-prescribing (including responding to refill
requests) to get credit for this measure.

Electronic Prescribing Denominator Criteria

Prescriptions are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks
They have been printed, Record this information from one of the following
faxed, or transmitted locations:
electronically m  Progress Notes > Treatment

m  Telephone/Web Encounter > Rx Tab
m  Telephone/Web Encounter > Virtual Visit tab > Treatment

IMPORTANT! The following medications are excluded from
the denominator:

m  Duplicate medications (re-printed, re-faxed, re-
transmitted, or printed and also transmitted)

m  Medication orders created from a mobile device
s OTC medications
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 2: Electronic Prescribing (eRx)

Note from CMS: As electronic prescribing of controlled substances is now possible,
providers may choose to include these prescriptions in their permissible prescriptions
where feasible and allowable by state and local law. If a provider chooses to include such
prescriptions, he or she must do so uniformly across all patients and across all allowable
schedules for the duration of the PI performance period.

Controlled substances can be included in denominator calculations for this measure by
enabling this option on the MAQ Dashboard:

N
T S |

Indude Controlled Substances in the denominator caloulstions of the L -
e-Presmbing maasure for the 2008 reporting pevicd Vit Ha L
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Electronic Prescribing Numerator Criteria

Prescriptions that satisfy the denominator are included in the numerator if they satisfy all of the

following criteria:

Objective 2: Electronic Prescribing (eRx)

Numerator Criteria

Area to Document within eClinicalWorks

They have been
queried for a drug
formulary from the Rx
Eligibility window

Record this information from one of the following locations:

m  Progress Notes > Treatment > green arrow next to Send Rx >
ePrescribe Rx > Rx Eligibility > Check Rx Eligibility

m  Appointment window > Rx Eligibility > Check Rx Eligibility

m  Progress Notes > Treatment > Add > Rx Eligibility > Check Rx
Eligibility

m  Telephone/Web Encounter > Rx tab > Rx Eligibility > Check Rx
Eligibility

m  Telephone/Web Encounter > Rx tab > green arrow next to Send
Rx > ePrescribe Rx > Rx Eligibility > Check Rx Eligibility

m  eRefill > Rx Eligibility > Check Rx Eligibility

IMPORTANT! Rx eligibility must be verified for all patients,
including self-pay patients, every time a prescription is sent.

Whenever an Rx Eligibility check is performed in eClinicalWorks,
the check lasts for three (3) days. Prescriptions and refill requests
created within the three days after an eligibility check has been
performed are considered verified.

Any prescription or refill request created after these three days
requires that a new eligibility check be performed in order to
satisfy this measure.

Note: A Scheduled Job can also be run every night (for scheduled
appointments only). You must verify Rx Eligibility manually before
e-Prescribing for walk-in appointments, Telephone/Web
Encounter orders, and eRefill requests.

Controlled substances can be included in denominator
calculations by enabling this option on the MAQ dashboard:

L]

N
Inciude Controled Substances in the denominator caloulitions of the Ll i
e-Ereseribing maasure for the 2018 regorting pericd Vs Ha L
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 2: Electronic Prescribing (eRx)

Numerator Criteria Area to Document within eClinicalWorks
They have been Record this information from one of the following locations:
transmitted using e- = E quick-launch link > Refill Rx or Error/Failed Rx

Prescription from the

m  Progress Notes > Treatment > green arrow next to Send Rx >
ePrescribe Rx window

ePrescribe Rx

m  Telephone/Web Encounter > Rx tab > green arrow next to Send
Rx > ePrescribe Rx

m  Telephone/Web Encounter > Virtual Visit > Treatment> green
arrow next to Send Rx > ePrescribe Rx

m  Progress Notes > Send

Note: e-Prescriptions dropped to fax due to NDC mismatch do
NOT count in the numerator

For more information on the processes that satisfy this measure, refer to the eClinicalWorks MU
- e-Prescription Eligibility and Formulary Checking and the eCW Auto-Eligibility Check Validation
documents.

Electronic Prescribing Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks

They write fewer than 100 This exclusion criterion is reported by self-attestation.
permissible prescriptions
during the PI reporting period

They do not have a pharmacy | This exclusion criterion is reported by self-attestation.
within their organization and
there are no pharmacies that
accept electronic
prescriptions within 10 miles
of the EP's practice location
at the start of his/her PI
reporting period
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Features Related to Electronic Prescribing

The following features are related to prescribing medications electronically:
m  Transmitting Prescriptions

m  Checking Rx Eligibility

m e-Prescribing Medications

Transmitting Prescriptions

m  Progress Notes > Treatment

w. Treatment (Test, Test - 03/19/2014 01:00 PM, ANN ¥ISIT)
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m Telephone/Web Encounter > Rx Tab

¥ Perform Eligibility Check
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 2: Electronic Prescribing (eRx)

Checking Rx Eligibility

m  Progress Notes > Treatment > green arrow next to Send Rx > ePrescribe Rx > Rx Eligibility > Check

Rx Eligibility
5
Patient Marme Testl, Testl | - Eligibility Criteria
Patient Address Fi First Name 3 Laszt Name ooB
I Testl Testl 20161018
10/18/2016 Eddvits it |
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Progress Notes > Treatment > Add > Rx Eligibility > Check Rx Eligibility

Treatment:
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Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 2: Electronic Prescribing (eRx)

m Telephone/Web Encounter > Rx tab > Rx Eligibility > Check Rx Eligibility
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e-Prescribing Medications

m £ quick-launch link > Refill Rx or Error/Failed Rx
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m Telephone/Web Encounter > Rx tab > green arrow next to Send Rx > ePrescribe Rx
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m Telephone/Web Encounter > Virtual Visit > Treatment> green arrow next to Send Rx > ePrescribe
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Objective 3: Clinical Decision Support (CDS)

Objective

Implement clinical decision support (CDS) interventions focused on improving performance on
high-priority health conditions.

IMPORTANT! EPs must satisfy both measures in order to meet the objective.

The following sections are related to objective 3:
m CDS1

m CDS2

m Features Related to CDS

m  Clinical Decision Support Rule Auditing

CDS 1

Measure

Implement five clinical decision support interventions related to four or more clinical quality
measures at a relevant point in patient care for the entire Pl reporting period. Absent four
clinical quality measures related to an EP’'s scope of practice or patient population, the clinical
decision support interventions must be related to high-priority health conditions.

IMPORTANT! EPs must attest YES to implementing five (5) clinical decision support
interventions related to four (4) or more CQMs at a relevant point in patient care for the
entire Pl reporting period.

CDS 2

Measure

The EP has enabled and implemented the functionality for drug-drug and drug-allergy
interaction checks for the entire Pl reporting period.

IMPORTANT! EPs must attest YES to enabling and implementing the functionality for drug-
drug and drug-allergy interaction checks for the entire Pl reporting period.

Note: This functionality is automatically enabled within eClinicalWorks.
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CDS 2 Exclusion Criteria

Providers may be excluded from this measure if they meet the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks

They have written fewer than This exclusion criterion is reported by self-attestation.
100 medication orders during
the Pl reporting period

Features Related to CDS

The following features are available to assist in decision-making:

Feature Area to Document within eClinicalWorks

Classic Alerts Access this feature from one of the following locations:
m  Executable: EMR > Alerts
m  Browser: Main Menu > eCW Menu > EMR > Alerts

Registry Alerts Access this feature from one of the following locations:

m  Executable: Registry band > Registry icon > run a query >
Save Queries

m  Browser: Main Menu > Registry icon > Registry link > run a
query > Save Queries

CDSS Alerts Access this feature from one of the following locations:
m  Executable: EMR > CDSS > Measure Configuration

m  Browser: Main Menu > eCW Menu > EMR > CDSS > Measure
Configuration

Drug Interaction Checks | Access this feature from one of the following locations:
m  Progress Notes > Current Medication > Drug Interaction
m  Progress Notes > Treatment > Interaction
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Configuring Classic Alerts

Objective 3: Clinical Decision Support (CDS)

This is a one-time setup process, with periodic maintenance as needed:

Executable: EMR > Alerts
Browser: Main Menu > eCW Menu > EMR > Alerts
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Configuring Registry Alerts

Executable: Registry band > Registry icon > run a query > Save Queries

Browser: Main Menu > Registry icon > Registry link > run a query > Save Queries
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Configuring CDSS Alerts

This is a one-time setup process, with yearly maintenance:

m Executable: EMR > CDSS > Measure Configuration

Browser: Main Menu > eCW Menu > EMR > CDSS > Measure Configuration
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Using Drug Interaction Checking

m  Progress Notes > Current Medication > Drug Interaction
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m  Progress Notes > Treatment > Interaction
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Clinical Decision Support Rule Auditing

The following features are related to clinical decision support rule auditing:
m CDS 1: CDSS Alerts
m  CDS 2: Drug/Drug and Drug/Allergy Interaction Check

CDS 1: CDSS Alerts

If you are meeting five (5) measures related to four (4) or more CDSS alerts:
1. To document how the CDSS alerts are set up:
a. Navigate to one of the following locations:
e Executable: EMR > CDSS > Measure Configuration

e Browser: Main Menu > eCW Menu > EMR > CDSS > Measure Configuration
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b. Take a screenshot of the Measure Configuration window:

NUMERATOR: "i.ll'l'lb;:rﬁf patients
x npeminator '
Patients see assigned PCG - ::::ﬂ 'T_Iﬂd ?EEDNE:PE ﬂlm::;c i unague patpents who were sesn in

Do patients sea their assigned the reparting period, who are not
premiary carae nivzr [PCE) 2 lh=| h:;?“:?::th::: :.?t::d beang sasn for the first time o the

pr ing periad health center

MHUMERATOR: NGF: Patents in the DENOHMINATOR: HOF: Women 18-
Chlamydia screening - denomanator who had st least one 25 wears of ags as of Decamber
Chlamydis screening Chilam ydis best during the 31 aof the measurement yaar who
MEEsuramsent year are savually schive,

DENOHINATOR: Humber of

2. To take screenshots of the CDSS alerts within the Patient Dashboard:

a. Open a patient's Progress Notes for an encounter taking place during the attestation
period.

b. Click the CDSS link in the Patient Dashboard:

Progress Notes

LAY, F S T

i o -

o -~ il

The CDSS Alerts window opens:

CDSS & Alerts.

Measure Mame Last Done Fgq Due Date

A1C testing 6 M D4/10/2012 o a0
Body Mass Index 02/08/2012 24 M 02/08/2014 g o
Patients seg assigned- PCG 12 M 020720128 J_:-_ G

c. Take a screenshot of this window.
3. To document the CDSS alerts within the Office Visit:

a. Open a patient's Progress Notes for an encounter taking place during the attestation
period.

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 46



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 3: Clinical Decision Support (CDS)

b. Click the CDSS tab in the right Chart Panel (ICW):

Yau are the primvary care giver for this patient
CcDSS Alerts

Aleohol use screening

Body Mass Index
Cholesterol screen {genl pop)
Depression screening

HIV screening

Sexual history taken
Smoking status

O0020200
S0P EOR

c. Take a screenshot of this tab.

IMPORTANT! Screenshots must show the implementation of Clinical Decision
Support Rules throughout the entire reporting period. Include the date/time on the
computer in the screenshots if there are no time stamps visible. Remove all patient
identifying information from screenshots for HIPAA compliance.

CDS 2: Drug/Drug and Drug/Allergy Interaction Check

Documentation for Measure 170.304(a) is different for Multum® and Medi-Span® drug
databases. First, determine which drug database the practice is using, and then use the
appropriate procedure to document this measure.

To determine which drug database the practice is using:
1. From the Progress Notes, click Treatment.

The Treatment window opens.
2. Click Add:

w. Treatment (Test, 101 - 12/06/2013 04:00 P, CON)

| Pt.onfo Encounter Physcal g Hib |

|obrePEs K R H DEHIL BALIS BEBHERO]
Rx Curfx .‘*- 1' = RO i Education w | oy | [ Pop Up ";ﬂ:l’&;l':z—r o
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The Manage Orders window opens:

Mo dboatn S_u.n‘emur‘y Add Mew B Add Maw Order
AETEZTHENTS [l:E e = = e e 11
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3. From the Type drop-down list, check for one of the following options:

¢ Multum Rx - If this option is selected, follow the steps in Multum Drug Database.
¢ Maedispan Rx - If this option is selected, follow the steps in Medi-Span Drug Database.

The option that displays is the drug database that the practice uses.
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Multum Drug Database
To document 170.304(a) if the practice uses the Multum Drug Database:

1. From the Progress Notes, click Treatment:
2. From the Treatment window, click /Interactions:

w, Treatment {Test, 101 - 12/06/2013 04:00 PM, CON)
| Pt Info Encounter Physical ) Hub
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The Drug Interaction window opens:

Adjust Severity —

r Muj.qr

Drug To Drug Interaction Description

Hypoprothrombinemic effects of Coumadin Cral
Tablet 2.5 MG may be increased by Zocor Oral " Moderate
Tablet 10 MG. Hematuria, epistaxis and rectal -
bleeding may occur.

Coumadin Oral  2ocor Oral Tablet
Tablet 2.5 MG 10 MiS

Minar
Reset

—— [Drug To Allergy Interaction - NONE

| Comiton | Sevrty |

MetFORMIN HCI

Precaution Description
MetFORMIN HCl Oral Tablet 500 MG is contraindicated in Renal

Oral Tablet 500 CHEM: Renal Disease. Since Chronic Renal Disease is a more specific form of
MG i Renal Disease, the same precaution may apply.
metrormin Hel - I tietrORMIN HCI Oral Tablat 500 MG should be used with extreme =
Hotes Time Stamp | Browse ... | Check Spalling | Action : 1 'I
| -
) print Preview | @9 print | glose |

3. Take a screenshot of this window at the beginning, middle, and end of the reporting period.

Note: Screenshots must include the date/time on the computer or a time stamp in the
Notes section that displays the date. Screenshots with this information must be taken
at the beginning, middle, and end of the reporting period.

Medi-Span Drug Database
To document 107.304(a) if the practice uses the Medi-Span Drug Database:
1. Navigate to one of the following locations:

& Executable: Reports > EMR > Drug Interaction Logs

& Browser: Main Menu > eCW Menu > Reports > EMR > Drug Interaction Logs

The Drug Interaction Log Report window opens:

Drug Interaction Log Report
= | BT 01072013 L 01072013 =
Ly Patisnl Prahbsr Actian Aeress Duts sl Tane
I

Tgnoee {0} Overirite (0 Cancel (0

2. Select the appropriate user from the User drop-down list.

3. Click the ellipsis button next to the From Date and To Date fields to open pop-up calendars

and select a date range.

The report runs automatically when you make changes to these filter fields.
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Objective 4. Computerized Provider Order Entry (CPOE)

Objective

Use computerized provider order entry (CPOE) for medication, laboratory, and diagnostic
imaging orders directly entered by any licensed healthcare professional, credentialed medical
assistant, or a medical staff member credentialed to and performing the equivalent duties of a
credentialed medical assistant, who can enter orders into the medical record per state, local,
and professional guidelines.

IMPORTANT! To restrict non-licensed healthcare professionals from entering orders on
your behalf, ensure that the security setting Treatment - Allows access to the treatment plan
from Progress Notes is unchecked for those non-licensed users. This restricts their access to
the Treatment section on the Progress Notes.

IMPORTANT! An EP, through a combination of meeting the thresholds and exclusions (or
both), must satisfy all three (3) measures for this objective:

The following sections are related to objective 4:
m  CPOE 1: Medication Orders

m  CPOE 2: Lab Orders

m  CPOE 3: Diagnostic Imaging Orders

m Features Related to CPOE

CPOE 1: Medication Orders

Measure

More than 60 percent of medication orders created by the EP during the Pl reporting period are
recorded using computerized provider order entry.

The following sections are related to CPOE 1:
m  CPOE 1 Denominator Criteria

m  CPOE 1 Numerator Criteria

m  CPOE 1 Exclusion Criteria
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CPOE 1 Denominator Criteria

Medications are included in the denominator if they satisfy the following criteria:

Denominator Criteria

Area to Document within eClinicalWorks

They have been created with
a Start status by an EP or a
member of the EP’s staff
during the PI reporting period

Record this information from one of the following
locations:

m  Progress Notes > Treatment > Add
m Telephone/Web Encounter > Rx tab > Select Rx

m  Telephone/Web Encounter > Virtual Visit tab > Treatment
> Add

Note: CPOE involves all methods of recording medications
in a structured manner. This includes any use of Order
Sets, Templates, e-Prescription, eCliniSense, and any other
methods of manually ordering medications on the
Treatment window of Progress Notes or the Rx tab/Virtual
Visit Treatment section of a Telephone/Web Encounter.

Medication orders created from a mobile device do NOT
count in the denominator.

CPOE 1 Numerator Criteria

Medications that satisfy the denominator are included in the numerator if they satisfy the

following criteria:

Numerator Criteria

Area to Document within eClinicalWorks

They have been entered by a
licensed healthcare
professional or credentialed
medical assistant

Record this information from one of the following
locations:

m  Admin > Staff > select staff member > check the Licensed
Medical Professional or Credentialed Medical Assistant
box

m  Progress Notes > Treatment > Add
m Telephone/Web Encounter > Rx tab > Select Rx

m  Telephone/Web Encounter > Virtual Visit tab > Treatment
> Add
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CPOE 1 Exclusion Criteria

Providers may be excluded from this measure if they meet the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks
They have written fewer than This exclusion criterion is reported by self-attestation.
100 mgdicatiqns during the Pl Note: This information can be retrieved from the
reporting period Denominator count.

CPQOE 2: Lab Orders

Measure

More than 60 percent of laboratory orders created by the EP during the Pl reporting period are
recorded using computerized provider order entry.

The following sections are related to CPOE 2:
m  CPOE 2 Denominator Criteria

m  CPOE 2 Numerator Criteria

m  CPOE 2 Exclusion Criteria

CPOE 2 Denominator Criteria

Lab orders are included in the denominator if they satisfy the following criteria:

Denominator Criteria Area to Document within eClinicalWorks
They have been created by an Record this information from one of the following
EP or a member of the EP’s locations:
staff during the PI reporting m  Progress Notes > Lab Reports
period m  Progress Notes > Treatment > Browse in the Labs
section

m  Telephone/Web Encounter > Labs/DI tab > select Labs
from drop-down list > New

m  Telephone/Web Encounter > Virtual Visit tab > Lab
Reports

m  Telephone/Web Encounter > Virtual Visit tab > Treatment
> Browse in the Labs section

m Patient Hub > Labs > New

Note: Lab orders created from a mobile device do NOT
count in the denominator.
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CPOE 2 Numerator Criteria

Lab orders that satisfy the denominator are included in the numerator if they satisfy the
following criteria:

Numerator Criteria Area to Document within eClinicalWorks
They have been entered by a Record this information from one of the following
licensed healthcare locations:
professional or credentialed m  Admin > Staff > select staff member > check the Licensed
medical assistant Medical Professional or Credentialed Medical Assistant
box

m  Progress Notes > Lab Reports

m  Progress Notes > Treatment > Browse in the Labs
section

m  Telephone/Web Encounter > Labs/DI tab > select Labs
from drop-down list > New

m  Telephone/Web Encounter > Virtual Visit tab > Lab
Reports

m  Telephone/Web Encounter > Virtual Visit tab > Treatment
> Browse in the Labs section

m Patient Hub > Labs > New

CPOE 2 Exclusion Criteria

Providers may be excluded from this measure if they meet the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks
They have written fewer than This exclusion criterion is reported by self-attestation.
100 Ialp order‘s during the PI Note: This information can be retrieved from the
reporting period Denominator count.

CPOE 3: Diagnostic Imaging Orders

Measure

More than 60 percent of diagnostic imaging orders created by the EP during the Pl reporting
period are recorded using computerized provider order entry.

The following sections are related to CPOE 3:

m CPOE 3 Denominator Criteria
m CPOE 3 Numerator Criteria
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m CPOE 3 Exclusion Criteria

CPOE 3 Denominator Criteria

Diagnostic Imaging orders are included in the denominator if they satisfy the following criteria:

Denominator Criteria

Area to Document within eClinicalWorks

They have been created by an
EP or a member of the EP’s
staff during the PI reporting
period

Record this information from one of the following
locations:

Progress Notes > Diagnostic Imaging

Progress Notes > Treatment > Browse in the Diagnostic
Imaging section

Telephone/Web Encounter > Labs/DI tab > select Imaging
from drop-down list > New

Telephone/Web Encounter > Virtual Visit tab > Diagnostic
Imaging

Telephone/Web Encounter > Virtual Visit tab > Treatment
> Browse in the Diagnostic Imaging section

Patient Hub > DI > New

Note: Diagnostic Imaging orders created from a mobile
device do NOT count for the denominator.

CPOE 3 Numerator Criteria

Diagnostic imaging orders that satisfy the denominator are included in the numerator if they

satisfy the following criteria:

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018

55



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 4: Computerized Provider Order Entry (CPOE)

Numerator Criteria

Area to Document within eClinicalWorks

They have been entered by a
licensed healthcare
professional or credentialed
medical assistant

Record this information from one of the following
locations:

Admin > Staff > select staff member > check the Licensed
Medical Professional or Credentialed Medical Assistant
box

Progress Notes > Diagnostic Imaging

Progress Notes > Treatment > Browse in the Diagnostic
Imaging section

Telephone/Web Encounter > Labs/DI tab > select Imaging
from drop-down list > New

Telephone/Web Encounter > Virtual Visit tab > Diagnostic
Imaging

Telephone/Web Encounter > Virtual Visit tab > Treatment
> Browse in the Diagnostic Imaging section

Patient Hub > DI > New

CPOE 3 Exclusion Criteria

Providers may be excluded from this measure if they meet the following criteria:

Exclusion Criteria

Area to Document within eClinicalWorks

They have written fewer than
100 diagnostic imaging
orders during the Pl reporting
period

This exclusion criterion is reported by self-attestation.

Note: This information can be retrieved from the
Denominator count.

Features Related to CPOE

The following features are related to recording medications using CPOE:

m  Recording Medications

m  Recording Labs

m Recording Diagnostic Imaging Orders

m Setting Up Staff Members as Licensed Healthcare Professionals/Credentialed Medical

Assistants
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Recording Medications

m  Progress Notes > Treatment > Add

w. Treatment (Test, 101 - 12/06/2013 D4:00 P, CON)
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m  Telephone/Web Encounter > Rx tab > Select Rx

E Telephone Encounter

|Rowte | Frequency | Curation | Dispe| Refill:] auth | awe{l Stop Dat]

Answered by Date Time [T High Priority 5 E:i
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Telephone/Web Encounter > Virtual Visit tab > Treatment > Add

E'Telephn ne Encounter *

Answered by Date Time ™ High Priority (i fi
[willis, Sam |10/ 7 72014 =] [8:21 M
Patient Hub Pr:f:!l.riuier ~Status -
Srith, James IWlIIls, Sam A j i* Cpen
LOB:11/11/1980 Age:337 Sex:M Pharmacy

el:503-475-0450 | 3 ﬁ " Addressed
Acct Mot AB11975, WebEnabled: Mo A d
Elgh Status: P a:gré';i:

Reviewed

Caller Facility
[ [seco FamiLy ke
Reason AssignedTo
| |=] [willie, sam A =l

¥ Perform Eligibility Check
Message] Rx | I.ahsj’DI] N.utesl Addendum I Log History ~ ¥irtual Visit

Plan:

Drencadiniroc®

W, Treatment (Test, 101 - 12/06/2013 04:00 PM, COM)

[0 e|Dms K RuR B DHEL BELZS BRREBO]
Rx_cuRx | =|[#48d | -] =Remove | edwation w | _Foriiay | popup ?:?Tﬁ - aop |
Abdoming scrta i | Dthers |
[Strength  |Formula| Take

& L] Commer| Hame IReute  |Frequency |Duiration  [Dispel Rofill] &tk 1AWE(] Stop Diat!

Recording Labs
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Plan:
Treatment:
Procedures:
Immunizations:
Therapeutic Injections:

Surgical Posting:
Diagnostic Imaging:

Lab Reports:
Disposition & Communication:

MNext Appointment:
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m  Progress Notes > Treatment > Browse in the Labs section

w, Treatment (Test, 101 - 12/06/2013 04:00 PM, CON)

_|w¢rmsnmmﬂwﬂuﬂb 4.|
@ be g/PEMSs W AWARD DLOHIL BOLPZE BRninan O

Generate i By

Rx Cwhx | ~| +add |-| = Ramowe | Edm Fariiary |V Pop p |t"‘ld f"l'.‘udu 'l'"ﬂ'ﬂ-p |

Abdominal sceta i | Others |

|Farrnuly| Take  |Route | Freguancy ! Durstion | Disps| fefilll Auth TAWEP Stap Dat)

g il Commar, Name | Stranath

Labs Browse ...

Band Ligation

m  Telephone/Web Encounter > Labs/DI tab > select Labs from drop-down list > New

H B Telephone Encounter *

| answered by Date Time ™ High Priority (i Ci
| [willis, S am 11077 /2014 | [8:21 AM
' Patient Lot ~status-
| [smith, James IW:Ihs, Sam A E[ _ & Open
DOB:11A11/1980 Age:33Y SexiM Pharmacy
Tel: S08-475-0450 l :I " Addressed
Acct Mo AB11975, WebEnabled: Mo Add 4
Elgh Status; i
" and Docs
Reviewad
caller Facility
| [sBCD FamILY [~
Reason AssignedTo
I [=] [witis, sam a = 3

¥ Perform Eligibility Check
Hessaqel Rx Nntesl ﬂ.ddenﬂuml Log Histnryl < ¥irtual \l'isitl

[Hew ||| Update ||| £

[Date [Hame [Reasan [Recaived [Result Reviewad
117142013 17-Hydroxycorbco:
11/14/2013  1-Methyl-histidine
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m Telephone/Web Encounter > Virtual Visit tab > Lab Reports

B Telephone Encounter *

Answered by Date Time I~ High Priority @ Lﬁ

fwillis, Sam |10¢7 s2014 =] [8:21 Am

Patient Info | ([ENTR| Provider ~ Status

Smith, James IW““‘-"- Samn A :I ﬁ & Open

DOB:11/11/1980 Age:33y Sex:M Pharmacy

Tel:S08-475-0450 I _'_,I a " Addressed

Acct No:AB11975, WebEnabled: No dd d

Elgh Status: P :nd?;;:
Reviewsd

Caller Facility

| [xBCD FAMILY [=]

Reason AssignedTo

[ [=] [withs, sam & Rl |

¥ Perform Eligibility Check
Hessagei R | Labs /D1 | Nute-sl Addendum] Log History |+ Virtual Visit

Plan: S
Treatment:
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m  Telephone/Web Encounter > Virtual Visit tab > Treatment > Browse in the Labs section

&

B Telephone Encounter

Answered by Date Time [T High Priority 6 ﬁ‘
[willis, Sarm |10/ 7 72014 =] [8:21 M el
Patient CI Provider ~Status——————
Srnith, James Iw*”"jl Sam A =l i Open
LOB:11/11/1980 Age:337 Sex:M Pharmacy

el:505-475-0450 | E m " Addressed
Acct Mot AB11975, WebEnabled: Mo ad d
Elgh Status: P ang'g;i:

Feviewed

caller Facility
| [sBCD FAMILY R4
Reason AssignedTo
| [*] [willis, Sam & =]

¥ Perform Eligibility Check
Messagel Ry | I.ahsj’DI] Nntesl Addendum | Log History | + ¥irtual visit

Plan:

I]l-nr-n!urns-

m Patient Hub > Labs > New

Patient Hub {Test, Test)

[ et Jimmrrin [ [ | o

Lih )
Tinard  Tinrh T Wm0 G T A 04N

oy Al
| B Show CC List B Show Canceled Grders hew | Delete | Comulatier Report
4 HHS O & & W Order Date Coll Date Result Date Labs Reason Result Recenved Reviewsd

Recording Diagnostic Imaging Orders

m  Progress Notes > Diagnostic Imaging

Plan:
Treatment:
Procedures:
Immunizations:

Therapeutic Injections:
Surgical Posting:

lDiaanustic: Imaainu:l

Lab Reports:

Disposition & Communication:
Next Appointment:
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m  Progress Notes > Treatment > Browse in the Diagnostic Imaging section

w, Treatment (Test, 101 - 12/06/2013 04:00 PM, CON)

@ e glD@Es X RERD DHTILPBOLIS B HED O
_ - T Generate HxBy
Ry Curkx ;vlm ]--J = Remawe I Ed.h:g{l:i:l‘l‘!"[ FArULAFS, !pmm | « Id " Code (" Group!

Abdominal sctta inga | Others |

gl Commar] Mama  |Stranoth | | Farrnulal Talkie.  |[Route | Frequancy |Duration | Dispe|fefill] Auth | AWPE Stap Dl

Band Ligation

m  Telephone/Web Encounter > Labs/Dl tab > select Imaging from drop-down list > New

EE 1elephone Encounter *

Answered by Date Time [T High Priority ﬁ lfi

| willis, Sam |10/7 /2014 =] [8:21 AM

Patient (info][EM FProvider — ~Status

Smith, Jarmes I_W'IIISJ Sarn A ﬂ & Open

COB: 1171171980 Age:33Y Sew:M Pharmacy

Tel:508-475-0450 | ~| " Addressed

Acck No:AB11975, WebEnabled: Mo add d

Elgh Status: ~ and'g;iﬁ
Feviewed

Caller Facility

| [xeco FamILY [~]

Reason AssignedTo

| || [witis, Sam & =l

¥ Perform Eligibility Check

Messagel Bx

Irnaging

Received Roeviewed
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m Telephone/Web Encounter > Virtual Visit tab > Diagnostic Imaging

!- Telephone Encounter *

Answered by Date Time ™ High Priority @ ‘:i
[willis, Sam [10/7 72014 =] [8:21 am '
Patient Frovider - Status - 1
S rnith, ISmEs [ wiltis, Sam A Bl | | & Goon
DOB:11/11/1980 Age:3dr Sex:M Pharmacy
Tel:S08-475-0450 I :i " Addressed
Acct No:AB11975, WebEnabled: Mo | Addracssd
Elgb Status: P tess

| Reviewed
Caller Facility
| BCD FAMILY &
Reason AssignedTo
[ [=] [wittis, Sam a Bl |

[ Perform Eligibility Check
Hesugel R I Labs /D1 l Nutell nddenﬂuml Log History |v Virtual Visit

[ Fax |
|

Plan:

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 63



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 4: Computerized Provider Order Entry (CPOE)

m Telephone/Web Encounter > Virtual Visit tab > Treatment > Browse in the Diagnostic Imaging
section

I 1elephone Encounter *

Answered by Date Time ™ High Priority @ @I
[willis, Sam |10/ 7 72014 +| [8:21 AW
Patient slall L ~Status
Srnith, James |1|l|I|II|s, Sam A =l * Open
COB11 /111960 Age:33y Sex:M Pharmacy
el:508-475-04 50 | 3 [' " addressed
Acct Mot AB11975, WebEnabled: Mo d
Elgh Status! Addresse
" and Docs
Reviewad
Caller Facility
|ABCD FaMILY H
Reason AssignedTo
| [+] [willis, sam & =l

¥ Perform Eligibility Check
Hessagei :4%) | I.ahsj’DI] Nntesl Addendum| Log History ~ Wirtual ¥isit

| Pt.Info Encounter Physical ) Hub
(@ |he &) -SIR|HHH¢@}JH¢&JEME PR Z2¢ BElfnE B o

~Germsrate HX By ——
qumrh vj -l-n.dd]v] -le ﬁmrmr‘mi
Others |

fulComme] Name  |Strength |Formul Take

Route |Frequenc|Duratiorr |Dispi] Refill] Auth | AWP | Stop Dz Na

m Patient Hub > DI > New

Faticnt Hub 1_T sk, l'rl.t'_i

| D1 | Procedures | tmm/Tinj | Referrals | ABergies | coss
T — “Soi Linko ——————am -

ammn: SH0.ATA. SOG4

| B showccist B Show Cancelied Orders Hew | Delete | Comulativer Report
4 HMS O 4 & W Order Date Coll Date Result Date Labs Reason Result Recenved Reviewsd
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Setting Up Staff Members as Licensed Healthcare Professionals/
Credentialed Medical Assistants

This is a one-time setup that must be performed for each staff member that will be recording
medications in the system:

m  Admin > Staff > select staff member > check the Licensed Medical Professional or Credentialed
Medical Assistant box

o Perponad I

Lawl Hame Fiewt Hame * Midkclie ingial It & PeROUr DR

| | I =

Prefix Siplfix Ieftical s

I e

Owtn of Birth Sotial Socurity Ho

I [ ™ Licensed Heskthcare Professional os Crod Meial Assi
Mg Addi s Cay DAati

| | |

Tip Code Hoerse Phone ]

| | [

Figer Primary Service Location

I [Select Faciny <] Dot Appoistment Provider | 5
2 Login [edo

e reaame Password Cordiem Password Sreliie

y R — Acive =

B - o i 6k T Wy Sttt frin SEadd
FSetect Sind =]
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Objective 5: Patient Electronic Access (PEA)

Objective

The EP provides patients (or patient-authorized representative) with timely electronic access to
their health information and patient-specific education.

IMPORTANT! Both PEA 1 and PEA 2 MUST be satisfied to meet the overall objective.

Note: For more information on setup and workflow for patient-authorized
representatives, refer to the eCW Patient Portal Release Notes - V8 - Feb 2018.

The following sections are related to objective 5:
m PEA 1: Provide Patient Access

m  PEA 2: Patient Education

m Features Related to PEA

PEA 1: Provide Patient Access

Measure

For more than 80 percent of all unique patients seen by the EP, both of the following criteria
must be satisfied:

m The patient (or the patient-authorized representative) is provided timely access to view
online, download, and transmit his or her health information.

m  The provider ensures the patient’s health information is available for the patient (or patient-
authorized representative) to access using any application of their choice that is configured
to meet the technical specifications of the Application Programming Interface (API) in the
provider's CEHRT.

The following sections are related to PEA 1:
m  PEA 1 Denominator Criteria
m  PEA 1 Numerator Criteria

m  PEA 1 Exclusion Criteria
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PEA 1 Denominator Criteria

Unique patients are included in the denominator if they satisfy ALL of the following criteria:

Objective 5: Patient Electronic Access (PEA)

Denominator Criteria

Area to Document within eClinicalWorks

They have had an outpatient
appointment with an eligible
professional during the Pl
reporting period

Record this information from one of the following

locations:

m  Practice > Resource Scheduling or provider's schedule
icon > double-click on an open time slot or right-click on
an open time slot and click New Appointment

m  Patient Hub > New Appointment

m  Registry band > Registry icon > filter patients and check
box next to a single patient > New Appointment

They have had a valid CPT*
code recorded by an eligible
professional during the PI
reporting period

Progress Notes > Visit Code > Add E&M

Note: The following CPT codes are considered valid
outpatient encounters:

92004, 92002, 92014, 92012, 99024, 99211, 99212, 99213,
99214, 99215, 99201, 99202, 99203, 99204, 99205, 99241,
99242, 99243, 99244, 99245, 99324, 99325, 99326, 99327,
99328, 99334, 99335, 99336, 99337, 99341, 99342, 99343,
99344, 99345, 99347, 99348, 99349, 99350, 99381, 99382,
99383, 99384, 99385, 99386, 99387, 99394, 99395, 99396,
99397, 99420, 99429, 99455, 99456, 90846, 90847, 90853,
90857, 90801, 90804, 90805, 90806, 90807, 90808, 90809,
90802, 90810, 90811, 90812, 90813, 90862, 90960, 90961,
90962, 90966, 90970, DO120, D0140, D0145, DO150, DO160,
D0170, D0180, D1110, D1120, GO438, G0439, G0402, 99304,
99305, 99306, 99307, 99308, 99309, 99310, 99315, 99316,
99318, 99391, 99392, 99393, 99356, 99324, 99325, 99326,
99327, 99334, 99335, 99336, 99337, 98940, 98941, 98942,
98943, 90785, 90791, 90792, 90832, 90833, 90834, 90836,
90837, 90838, 99495, 99496, 59425, 59426, 59430, 99024,
H1000, 99999, 97802, 97803, 99401, 99402, 99403, 99404,
99361, 99221, 99222, 99223, MUOBV, MUREP

*. CPT copyright 2018 American Medical Association. All rights reserved.
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PEA 1T Numerator Criteria

Unique patients that satisfy the denominator are included in the numerator if they satisfy the

following criteria:

Objective 5: Patient Electronic Access (PEA)

Numerator Criteria

Area to Document within eClinicalWorks

They have been web-enabled
on their initial appointment
during the Pl reporting period
for timely access to health
information (within 48 hours
of information becoming
available to the provider)

Record this information from one of the following

locations:

m  Appointment window > enter e-mail address in E-mail
field > check the W box

m  Appointment window > set Visit Status to Arrived > enter
their e-mail address in the E-mail field or check the Don't
Web Enable box and select a reason from the Reason
drop-down list

They have access to their
health information within 48
hours of that information
becoming available to the
provider through an API
enabled by the practice

Enable the Interoperability Hub from the following location:

m  Admin > Product Activation > Interoperability Hub >
Activate

Note: There may be additional costs associated with
building an Interoperability interface.

the reporting period.

IMPORTANT! Any patient with multiple encounters during the PI reporting period must have
access to the information related to their care for each encounter where they are seen by the
EP. Therefore, patients MUST be web-enabled or opted-out from their very first visit during

Patients may opt out if they do not have an e-mail address or they choose not to disclose this
information to your practice. Patients MUST be opted out from the Appointment window
(NOT the Patient Information window) to satisfy this numerator. For more information, refer
to Documenting Patients that Opt Out of Being Web-Enabled.

Documenting Patients that Opt Out of Being Web-Enabled

Patients that opt out of being web-enabled satisfy the numerator for this measure. This MUST
be documented from the Web Enable Patient pop-up window that displays on the Appointment
window during check-in. Opting a patient out from the Patient Information window does NOT

give credit for this measure.

To document that a patient opted out of being web-enabled:

1. From the Appointment window, mark the patient as Arrived, then click OK.

Note: Visit Statuses can be configured as Arrived from EMR > eCW Visit Codes.
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The Web Enable Patient window opens.

IMPORTANT! This pop-up window is enabled by an item key. If the pop-up window
does not open after following this step, open a case with eClinicalWorks support to ask
for the MUParticipate item key to be enabled.

2. Click the Opt Out radio button, then click OK.

PEA 1 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks

They have no office visits This exclusion criterion is reported by self-attestation.
during the PI reporting period

They conduct 50 percent or This exclusion criterion is reported by self-attestation.
more of their patient
encounters in a county that
does not have 50 percent or
more of its housing units with
4Mbps broadband availability
according to the latest
information available from
the FCC on the first day of
the Pl reporting period

PEA 2: Patient Education

Measure

The EP must use clinically relevant information from CEHRT to identify patient-specific
educational resources and provide electronic access to those materials to more than 35 percent
of unique patients seen by the EP during the Pl reporting period.

The following sections are related to PEA 2:
m  PEA 2 Denominator Criteria
m  PEA 2 Numerator Criteria

m  PEA 2 Exclusion Criteria
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PEA 2 Denominator Criteria

Unique patients are included in the denominator if they satisfy ALL of the following criteria:

Objective 5: Patient Electronic Access (PEA)

Denominator Criteria

Area to Document within eClinicalWorks

They have had an outpatient
appointment with an eligible
professional during the Pl
reporting period

Record this information from one of the following

locations:

m  Practice > Resource Scheduling or provider's schedule
icon > double-click on an open time slot or right-click on
an open time slot and click New Appointment

m  Patient Hub > New Appointment

m  Registry band > Registry icon > filter patients and check
box next to a single patient > New Appointment

They have had a valid CPT*
code recorded by an eligible
professional during the PI
reporting period

Progress Notes > Visit Code > Add E&M

Note: The following CPT codes are considered valid
outpatient encounters:

92004, 92002, 92014, 92012, 99024, 99211, 99212, 99213,
99214, 99215, 99201, 99202, 99203, 99204, 99205, 99241,
99242, 99243, 99244, 99245, 99324, 99325, 99326, 99327,
99328, 99334, 99335, 99336, 99337, 99341, 99342, 99343,
99344, 99345, 99347, 99348, 99349, 99350, 99381, 99382,
99383, 99384, 99385, 99386, 99387, 99394, 99395, 99396,
99397, 99420, 99429, 99455, 99456, 90846, 90847, 90853,
90857, 90801, 90804, 90805, 90806, 90807, 90808, 90809,
90802, 90810, 90811, 90812, 90813, 90862, 90960, 90961,
90962, 90966, 90970, DO120, D0140, D0145, DO150, DO160,
D0170, D0180, D1110, D1120, GO438, G0439, G0402, 99304,
99305, 99306, 99307, 99308, 99309, 99310, 99315, 99316,
99318, 99391, 99392, 99393, 99356, 99324, 99325, 99326,
99327, 99334, 99335, 99336, 99337, 98940, 98941, 98942,
98943, 90785, 90791, 90792, 90832, 90833, 90834, 90836,
90837, 90838, 99495, 99496, 59425, 59426, 59430, 99024,
H1000, 99999, 97802, 97803, 99401, 99402, 99403, 99404,
99361, 99221, 99222, 99223, MUOBV, MUREP

*. CPT copyright 2018 American Medical Association. All rights reserved.
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PEA 2 Numerator Criteria

Unique patients that satisfy the denominator are included in the numerator if they satisfy at
least ONE of the following criteria:

Numerator Criteria Area to Document within eClinicalWorks
They were provided Record this information from one of the following
electronic access to patient- locations:
specificeducational resources | m  Progress Notes > Treatment > Education > Patient
using clinically relevant Education > select education based on diagnosis or
information identified from medications entered > Publish to Portal*

CEHRT during the PI

m  Progress Notes > Send > For Patients
reporting period

IMPORTANT! Custom education, Order Set education, AND
Rx education no longer count toward this measure

Note: When patient education is published to the Patient
Portal, the encounter provider is credited for this measure.

*. Users MUST be signed up with one of the third-party education vendors to have access to Patient Education fea-

tures. These vendors include Healthwise®, Santovier, Elsevier®, ADAM (effective March 14, 2018), or Krames (effec-
tive May 16, 2018).

PEA 2 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks
Any EP who has no office This exclusion criterion is reported by self-attestation.
visits during the Pl reporting
period
They conduct 50 percent or This exclusion criterion is reported by self-attestation.

more of their patient
encounters in a county that
does not have 50 percent or
more of its housing units with
4Mbps broadband availability
according to the latest
information available from
the FCC on the first day of
the Pl reporting period
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Features Related to PEA

The following features are related to PEA:
m  Recording Appointments

m Recording E&M Codes

m  Web-Enabling Patients

m Recording Patients’ e-Mail Addresses
m  Ordering Education

Recording Appointments

m Practice > Resource Scheduling or provider's schedule icon > double-click on an open time
slot or right-click on an open time slot and click New Appointment

Resource Scheduling -~
P8 [ Detaks ~Scheduss, Appo
T T Slot: EI'S TI
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m Patient Hub > New Appointment

Procedure
f\
ImmT.In§
‘_—P
Referral

T

Allergies

a8

Emcounters

CDss

Ry

Rx

E

Patient Hub

AC

= 0172071942

count No: e9362 | Messenger Enabled:

Web Enasbled: No |

oilection Balance

Account Balance

Collection Status

Billing Alert

Account Inguiry

£0.00
- 50.00
$0.00

Guarantor Balance

- Billing Log=

Appointments

Last Appointment
Facilin
Next Appointment

Facilimy

01/08/2018 03:30 PM
12:Btest

Bumped Appt: NONE  Case Manager Hx:

New Appointment

Objective 5: Patient Electronic Access (PEA)

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (Pl) Stage 3 for Medicaid EPs in 2018 73



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 5: Patient Electronic Access (PEA)

m Registry band > Registry icon > filter patients and check box next to a single patient > New
Appointment

© Registry -
m-:- b Frocedarw - KD | 4PT | RN | OhafComplaran || Medos satory | Ty | Bodoumess  Ssunorod Tere Beoony | Sewd Beooes - Reenss Repoins | ALemed

AgeFanger | F M X | ) v Faciizy = - Foaé
TES ah N e = Wi doin ® = & L
Tip Coce Ers Begudare = Lespuage > Feogram
Bl {Acta) = AR A RO NI = Fatene Seanrn Doaaes [P Decesten || Regiatry Dasroes | Beside Bessheane
o S w Boch AND Do = AN

’;.h-ﬂl Dhortrres P Sudbsas (Mo oy Tl

Limer s | Ron Lemer. | | Fiowshees| | Pacieinr Mo Messonpes B of Bemads (5 L k- T wees B

Recording E&M Codes

m Progress Notes > Visit Code > Add E&M

I
Procedure Code add CPT | Aemove| EM Codar| Medicare Edits | ¥ Fop Up
[CPT [Maine iniesiMy[mzTMalme ot 1602 D3 TCD4

Billing Information:
» O0213 Office Visit,

Procedurs Codas;

99215 Office Visit, Est Pt, 1.00 1 250001 2 250012
-
j

Web-Enabling Patients

m  Appointment window > enter e-mail address in E-mail field > check the W box

HE Appointment on Monday, October 06, 2014 |
‘ Oty Encounters @ Find €7 Loo: Referrals < Orders PE]Bubbleshest O|
Facility IInternaI-DEMD DASHEDARD (PM) el | pos |11
Date |10 6 fz014 x| Provider |wilis, Sam,Muli |
Clalm Providers | Resource I'-.-'-.-'illis,Sam,MuIti j
Start Time: [ 10:00 AM x| EndTime |10:15 &M =l [~ Hew Pt
Patient ITest,Dn:n:ument Sel | lﬁF.:._l Hut.l Elgib Sts
DOE [03/02/1973 Tel | E-mailrestz@amail. com v w
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Recording Patients’ e-Mail Addresses

m  Appointment window > set Visit Status to Arrived > enter their e-mail address in the E-mail
field or check the Don't Web Enable box and select a reason from the Reason drop-down list

Web Enable Patient

To comply with MeaningfulUse Measure 170.304(f) which requires patients to have
access to Personal Health Record, it is recommended to Web Enable patients.

Note: Check the Don't Web Enable box if the patient declines to be web enabled, or if
the patient dees not have an E-mail address/account.

Patient portal web enabled: No

E-mail™

[l oen't Web Enable Reason:
Does not have E-Mail
Coes notwantto be web enabled
Does notwantto share E-Mail
Other
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Ordering Education

m  Progress Notes > Treatment > Education > Patient Education > select education based on
diagnosis or medications entered > Publish to Portal

. Treatmieid [ Ties uirstEdalion o 90240004 PREE AM, NP)
| PLtels Enconter Phoscl o teh
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m  Progress Notes > Send > For Patients

Plan:
Treatment:

Others
Start Hy
01/22/2018, F
Start Gl
Start Date: 01
Procedures:

Immunizatic

Therags
N Common Send | ,TOM 35
Lab R
Proce Patient Orders Eor Patients
Preve
Mext . ; )
& Patient Education
Billi ng Patient Education
Visit ¢
Proce = visit Summary

Send
) L1 . Prinfw

Visir Summ

Objective 6: Coordination of Care Through Patient

Patient Education

Welcome

¥| Diabetes (type 2) (&)
This disease is the most comman form ¢

diabetes can lead to many serious prot-

Contains: diabeles

|:| Diabetes and foot care: video oven
It's important for people with diabetes i
lead fo the loss of a toe, Toot or leg.
Contains, diabeles

[_| Diabetes: Technologies Make It Eas
Technoiogy offers people with diabetes
wark.

Contains: diabetes

i 4 (DE i 4 5

SAVE AND PUBLISH TO PORTAL

Objective 6: Coordination of Care Through Patient

Engagement (CCTPE)

Objective

Use CEHRT to engage with patients or their authorized representatives about the patient's care.

Measures

There are three measures for this objective. Providers must attest to all three measures and
meet the thresholds for at least two of the measures to meet the objective.
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The following sections are related to objective 6:

m CCTPE 1: VDT

m  CCTPE 2: Secure Messaging

m CCTPE 3: Patient Generated Health Data (PGHD)
m Features Related to CCTPE

CCTPE 1: VDT

Measure

More than five (5) percent of all unique patients (or their authorized representatives) seen by
the EP actively engage with the electronic health record made accessible by the provider and
either:

1. View, download or transmit to a third party their health information; or

2. Access their health information through the use of an API that can be used by applications
chosen by the patient and configured to the APl in the provider's CEHRT; or

3. A combination of (1) and (2) The following sections are related to CCTPE 1

Note: For more information on setup and workflow for patient-authorized
representatives, refer to the eCW Patient Portal Release Notes - V8 - Feb 2018.

The following sections are related to CCTPE 1:
m  CCTPE 1 Denominator Criteria

m  CCTPE 1 Numerator Criteria

m  CCTPE 1 Exclusion Criteria
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CCTPE 1 Denominator Criteria

Unique patients are included in the denominator if they satisfy ALL of the following criteria:

Denominator Criteria Area to Document within eClinicalWorks
They have had an outpatient Record this information from one of the following
appointment with an eligible locations:
professional during the PI m Practice > Resource Scheduling or provider's schedule
reporting period icon > double-click on an open time slot or right-click on

an open time slot and click New Appointment
m  Patient Hub > New Appointment

m  Registry band > Registry icon > filter patients and check
box next to a single patient > New Appointment

They have had a valid CPT* Progress Notes > Visit Code > Add E&M
code recorded by an eligible Note: The following CPT codes are considered valid
professional during the Pl outpatient encounters:

reporting period 92004, 92002, 92014, 92012, 99024, 99211, 99212, 99213,

99214, 99215, 99201, 99202, 99203, 99204, 99205, 99241,
99242, 99243, 99244, 99245, 99324, 99325, 99326, 99327,
99328, 99334, 99335, 99336, 99337, 99341, 99342, 99343,
99344, 99345, 99347, 99348, 99349, 99350, 99381, 99382,
99383, 99384, 99385, 99386, 99387, 99394, 99395, 99396,
99397, 99420, 99429, 99455, 99456, 90846, 90847, 90853,
90857, 90801, 90804, 90805, 90806, 90807, 90808, 90809,
90802, 90810, 90811, 90812, 90813, 90862, 90960, 90961,
90962, 90966, 90970, DO120, D0140, D0145, DO150, DO160,
D0170, D0180, D1110, D1120, GO438, G0439, G0402, 99304,
99305, 99306, 99307, 99308, 99309, 99310, 99315, 99316,
99318, 99391, 99392, 99393, 99356, 99324, 99325, 99326,
99327, 99334, 99335, 99336, 99337, 98940, 98941, 98942,
98943, 90785, 90791, 90792, 90832, 90833, 90834, 90836,
90837, 90838, 99495, 99496, 59425, 59426, 59430, 99024,
H1000, 99999, 97802, 97803, 99401, 99402, 99403, 99404,
99361, 99221, 99222, 99223, MUOBV, MUREP

*. CPT copyright 2018 American Medical Association. All rights reserved.
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CCTPE 1T Numerator Criteria

Unique patients that satisfy the denominator are included in the numerator if they satisfy at

least ONE of the following criteria:

Objective 6: Coordination of Care Through Patient

Numerator Criteria

Area to Document within eClinicalWorks

They have viewed their health
information by logging in to
the Patient Portal

Web browser > URL > enter information in Username and
Password fields > Sign In > view a Visit Summary or PHR
record

They have downloaded their
PHR or Visit Summary from
the Patient Portal

Record from one of the following locations:

m Patient Portal > Request PHR or View Medical Records >
set date range > Submit

m Patient Portal > Medical Records > Personal Health
Record > set date range > Submit

m Patient Portal > Medical Records > Visit Summary tab >
Visit Summary button next to the desired visit summary

They have transmitted their
health information to a third
party from one of the links
on the Patient Portal

Record from one of the following locations:

m Patient Portal > Request PHR or View Medical Records >
set date range > Submit > Share

m Patient Portal > Medical Records > Personal Health
Record > set date range > Submit > Share

m Patient Portal > Medical Records > Visit Summary tab >
Visit Summary button > Share

IMPORTANT! Transmitting health information to a third
party requires the patient to enter the direct address of the
provider. Providers can request a direct address after
enrolling in JTN (Join the Network) from the eClinicalWorks
EMR.

For more information, refer to Requesting a Direct Address.

Note: Patients need to have viewed, downloaded, or
transmitted their health information within the PI
measurement period for numerator credit.

Note: Logging in from the healow™ App or healow.com
does NOT count toward the numerator.
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Numerator Criteria

Area to Document within eClinicalWorks

They have accessed their
health information through
the use of an API

Patients should contact the practice and use the practice
enabled API.

IMPORTANT! Practices must enable the Interoperability
Hub for patients to have access to their health information
through an API.

This hub is enabled from Admin > Product Activation >
Interoperability Hub > Activate.

There may be additional costs associated with building an
interface.

Note: For more information on the options available to patients from the Patient Portal,
refer to the Patient Portal Users Guide or the HelpHub.

CCTPE 1 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria

Area to Document within eClinicalWorks

They have no office visits
during the PI reporting period

This exclusion criterion is reported by self-attestation.

They conduct 50 percent or
more of their patient
encounters in a county that
does not have 50 percent or
more of its housing units with
4 MBPS broadband
availability, according to the
latest information available
from the FCC on the first day
of the PI reporting period.

This exclusion criterion is reported by self-attestation.

Information on broadband availability can be found at:
http://www.broadbandmap.gov/
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CCTPE 2: Secure Messaging

Measure

More than five (5) percent of all unique patients seen by the EP during the PI reporting period, a
secure message was sent using the electronic messaging function of CEHRT to the patient (or
the patient-authorized representative), or in response to a secure message sent by the patient
or their authorized representative.

Note: For more information on setup and workflow for patient-authorized
representatives, refer to the eCW Patient Portal Release Notes - V8 - Feb 2018.

The following sections are related to CCTPE 2:
m  CCTPE 2 Denominator Criteria

m  CCTPE 2 Numerator Criteria

m  CCTPE 2 Exclusion Criteria
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CCTPE 2 Denominator Criteria

Unique patients are included in the denominator if they satisfy ALL of the following criteria:

Denominator Criteria Area to Document within eClinicalWorks
They have had an outpatient Record this information from one of the following
appointment with an eligible locations:
professional during the PI m Practice > Resource Scheduling or provider's schedule
reporting period icon > double-click on an open time slot or right-click on

an open time slot and click New Appointment
m  Patient Hub > New Appointment

m  Registry band > Registry icon > filter patients and check
box next to a single patient > New Appointment

They have had a valid CPT* Progress Notes > Visit Code > Add E&M
code recorded by an eligible Note: The following CPT codes are considered valid
professional during the Pl outpatient encounters:

reporting period 92004, 92002, 92014, 92012, 99024, 99211, 99212, 99213,

99214, 99215, 99201, 99202, 99203, 99204, 99205, 99241,
99242, 99243, 99244, 99245, 99324, 99325, 99326, 99327,
99328, 99334, 99335, 99336, 99337, 99341, 99342, 99343,
99344, 99345, 99347, 99348, 99349, 99350, 99381, 99382,
99383, 99384, 99385, 99386, 99387, 99394, 99395, 99396,
99397, 99420, 99429, 99455, 99456, 90846, 90847, 90853,
90857, 90801, 90804, 90805, 90806, 90807, 90808, 90809,
90802, 90810, 90811, 90812, 90813, 90862, 90960, 90961,
90962, 90966, 90970, DO120, D0140, D0145, DO150, DO160,
D0170, D0180, D1110, D1120, GO438, G0439, G0402, 99304,
99305, 99306, 99307, 99308, 99309, 99310, 99315, 99316,
99318, 99391, 99392, 99393, 99356, 99324, 99325, 99326,
99327, 99334, 99335, 99336, 99337, 98940, 98941, 98942,
98943, 90785, 90791, 90792, 90832, 90833, 90834, 90836,
90837, 90838, 99495, 99496, 59425, 59426, 59430, 99024,
H1000, 99999, 97802, 97803, 99401, 99402, 99403, 99404,
99361, 99221, 99222, 99223, MUOBV, MUREP

*. CPT copyright 2018 American Medical Association. All rights reserved.
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CCTPE 2 Numerator Criteria

Objective 6: Coordination of Care Through Patient

Unique patients that satisfy the denominator are included in the numerator if they satisfy the

following criteria:

(or patient-authorized
representative) during the Pl
reporting period

box > Send

Send

box > Send

Numerator Criteria Area to Document within eClinicalWorks
The provider has sent a Record web-enable status from one of the following
secure electronic message to locations:
the patient (or patient- m  Appointment window > set Visit Status to Arrived > enter
authorized representative) or their e-mail address in the E-mail field
in response to a secure m  Appointment > enter e-mail address in the E-mail field >
message sent by the patient check the W box

m  Patient Information > Options > Web Enable

Record the sending of or replying to messages from one of

the following locations:

m  Executable: Patient Hub > Send eMsg > enter
information in the Subject and Message fields or use an
existing template > check the Preventive/Follow-up Care

m  Browser: Patient Hub > Send Message > check the
eMessage box in the Choose Modality section > enter
information in the Subject and Message fields or use an
existing template > check the Health Maintenance box >

m  Executable: Patient Hub > New Web Enc > select an
option from the Reason drop-down list > enter
information in the Action Taken field > Reply to Patient >
enter information in the Subject and Message fields or
use an existing template > check the Preventive/Follow-
up Care box > Send

m  Browser: Patient Hub > New Web Enc > select an option
from the Reason drop-down list > Reply to Patient >
check the eMessage box in the Choose Modality section
> enter information in the Subject and Message fields or
use an existing template > check the Health Maintenance

(continued on next page)
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Objective 6: Coordination of Care Through Patient

Numerator Criteria

Area to Document within eClinicalWorks

(continued from previous page)

Executable: Registry band > Lookup Encounters > set the
filters and click Filter > check the Show Unique Patients

box > Lookup > check the boxes next to the patients to

whom you want to send a message > Send eMsg > enter
information in the Subject and Message fields or use an
existing template > check the Preventive/Follow-up Care
box > Send

Browser: Registry menu > Lookup Encounters > set the
filters and click Filter > check the Show Unique Patients
box > Filter > check the boxes next to the patients to
whom you want to send a message > Send Message >
check the eMessage box in the Choose Modality section
> enter information in the Subject and Message fields or
use an existing template > check the Health Maintenance
box > Send

Executable: Registry band > Lookup Encounters > Blast
eMsg > Yes > enter information in the Subject and
Message fields or use an existing template > check the
Preventive/Follow-up Care box > Send

Browser: Registry menu > Lookup Encounters > Blast
eMsg > Yes > check the appropriate boxes in the Choose
Modality section > enter information in the Subject and
Message fields or use an existing template > check the
Health Maintenance box > Send

Executable: Registry band > Registry icon >
Demographics tab > set the filters > select Web Enabled
from the Select drop-down list > Run New > Encounters
tab > set the filters > Run Subset > check the boxes next
to the patients to whom you want to send a message >
Send eMsg > enter information in the Subject and
Message fields or use an existing template > check the
Preventive/Follow-up Care box > Send

(continued on next page)
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Numerator Criteria

Area to Document within eClinicalWorks

(continued from previous page)

m  Browser: Registry menu > Registry icon > Demographics
tab > set the filters > select Web Enabled from the Select
drop-down list > Run New > Encounters tab > set the
filters > Run Subset > check the boxes next to the
patients to whom you want to send a message >
Messenger > check the eMessage box in the Choose
Modality section > enter information in the Subject and
Message fields or use an existing template > check the
Health Maintenance box > Send

Note: The following types of messages on the Patient
Portal are considered secure web messages: Lab Results
and eMessages.

Note: If using the executable version of eClinicalWorks,
Preventive/Follow-up care message box MUST be checked.

If using the browser version of eClinicalWorks, the Health
Maintenance box MUST be checked.

IMPORTANT! Appointment reminders do not satisfy this
measure.

CCTPE 2 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria

Area to Document within eClinicalWorks

reporting period

4Mbps broadband availability
(according to the latest
information available from the
FCC on the first day of the PI

They have had no office visits This exclusion criterion is reported by self-
during the measurement period attestation.

They conduct 50% or more of This exclusion criterion is reported by self-
their patient encountersin a attestation.

county that does not have 50% or | |nformation on broadband availability can be
more of its housing units with found at: http://www.broadbandmap.gov/
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CCTPE 3: Patient Generated Health Data (PGHD)

Measure

Patient-generated health data or data from a nonclinical setting is incorporated into the CEHRT
for more than five percent of all unique patients seen by the EP during the Pl reporting period.

The following sections are related to CCTPE 3:
m  CCTPE 3 Denominator Criteria

m  CCTPE 3 Numerator Criteria

m  CCTPE 3 Exclusion Criteria

CCTPE 3 Denominator Criteria

Unique patients are included in the denominator if they satisfy ALL of the following criteria:

Denominator Criteria Area to Document within eClinicalWorks
They have had an outpatient Record this information from one of the following
appointment with an eligible locations:
professional during the PI m  Practice > Resource Scheduling or provider's schedule
reporting period icon > double-click on an open time slot or right-click on

an open time slot and click New Appointment
m  Patient Hub > New Appointment

m  Registry band > Registry icon > filter patients and check
box next to a single patient > New Appointment
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Objective 6: Coordination of Care Through Patient

Denominator Criteria

Area to Document within eClinicalWorks

They have had a valid CPT*
code recorded by an eligible
professional during the PI
reporting period

Progress Notes > Visit Code > Add E&M

Note: The following CPT codes are considered valid
outpatient encounters:

92004, 92002, 92014, 92012, 99024, 99211, 99212, 99213,
99214, 99215, 99201, 99202, 99203, 99204, 99205, 99241,
99242, 99243, 99244, 99245, 99324, 99325, 99326, 99327,
99328, 99334, 99335, 99336, 99337, 99341, 99342, 99343,
99344, 99345, 99347, 99348, 99349, 99350, 99381, 99382,
99383, 99384, 99385, 99386, 99387, 99394, 99395, 99396,
99397, 99420, 99429, 99455, 99456, 90846, 90847, 90853,
90857, 90801, 90804, 90805, 90806, 90807, 90808, 90809,
90802, 90810, 90811, 90812, 90813, 90862, 90960, 90961,
90962, 90966, 90970, D0O120, D0140, D0145, DO150, D0O160,
D0170, D0180, D1110, D1120, G0438, G0439, G0402, 99304,
99305, 99306, 99307, 99308, 99309, 99310, 99315, 99316,
99318, 99391, 99392, 99393, 99356, 99324, 99325, 99326,
99327, 99334, 99335, 99336, 99337, 98940, 98941, 98942,
98943, 90785, 90791, 90792, 90832, 90833, 90834, 90836,
90837, 90838, 99495, 99496, 59425, 59426, 59430, 99024,
H1000, 99999, 97802, 97803, 99401, 99402, 99403, 99404,
99361, 99221, 99222, 99223, MUOBV, MUREP

*. CPT copyright 2018 American Medical Association. All rights reserved.
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CCTPE 3 Numerator Criteria

Unique patients that satisfy the denominator are included in the numerator if they satisfy the

following criteria:

Objective 6: Coordination of Care Through Patient

Numerator Criteria

Area to Document within eClinicalWorks

They had data from a non-
clinical setting, which may
include patient-generated
health data, captured
through CEHRT into the
patient record during the PI
reporting period

Record this information from one of the following

locations:

m  Progress Notes > click healow™ Hub icon at top of
window (red square bracket with downward-facing
arrow) > click Import Current Page to import all answers
or click a download icon (downward-facing arrow) next
to an answer to import just that answer

m  Progress Notes > click the healow™ Hub Tracker icon
(blue zig-zag arrow)

For more information on patient-led healow Tracker
workflow, refer to the healow Hub Guide.

Note: Your practice can set up a questionnaire on your
Patient Portal that can be filled out by the patient and
incorporated into the patient record through CEHRT.

For more information on creating a questionnaire, refer to
the Patient Portal Users Guide.

Note: The healow Hub download icon is displayed only for
the specific provider with whom the appointment was
scheduled and is visible only on the Progress Notes for that
specific encounter.

The questionnaire itself is saved in Patient Documents
under the Chart Documents folder.

Note: The patient’s Visit Status must be marked as Arrived
to display the healow Hub download icon or the healow
Trackers icon (if applicable data is available).

Note: Billing, payment, and insurance-related information
does NOT satisfy this measure.
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CCTPE 3 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria

Area to Document within eClinicalWorks

They have had no office visits during the
measurement period

This exclusion criterion is reported by self-
attestation.

They conduct 50% or more of their
patient encounters in a county that does
not have 50% or more of its housing
units with 4Mbps broadband availability
(according to the latest information
available from the FCC on the first day of
the Pl reporting period

This exclusion criterion is reported by self-
attestation.

Information on broadband availability can be
found at: http://www.broadbandmap.gov/

Features Related to CCTPE

The following features are related to CCTPE:

Recording Appointments

Recording Patients’ e-Mail Addresses
Web-Enabling Patients

Recording E&M Codes

Sending Messages to Patients

Replying to Secure Messages from Patients
Importing Questionnaire Answers from the
Review healow Hub Tracker Data

Logging In to the Patient Portal
Downloading PHRs or Visit Summaries

Transmitting Health Information

Patient Portal
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Recording Appointments

m Practice > Resource Scheduling or provider's schedule icon > double-click on an open time
slot or right-click on an open time slot and click New Appointment

Resource Scheduling =~

o g | fs 2

PMew Appointrant
Mew Block
a0 To Togbary
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m Patient Hub > New Appointment

Patient Hub

I
S2 01/20/1942

Account Mo: 9362 | Messenger Enabled:
Web Enasbled: No |

Procedure
f‘\
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Pazient Balance £0.00
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Collection Status
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E Appointments
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Next Appointment
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Bumped Appt: NONE  Case Manager Hx:

New Appointment
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Registry band > Registry icon > filter patients and check box next to a single patient > New
Appointment

& Registry -
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Recording Patients’ e-Mail Addresses

Appointment window > set Visit Status to Arrived > enter their e-mail address in the E-mail
field

Web Enable Patient

To comply with Meaningfullse Measure 170.304(f) which requires patients to have
access to Personal Health Record, it is recommended to Web Enable patients.

Note: Check the Den't Web Enable bax if the patient declines to be web enabled, or if
the patient does not have an E-mail addressfaccount.

Patient portal web enabled: No

E-mail®

l

[l pen't web Enable Reazan:

Does not have E-Mail

Does notwantto be web enabled
Does notwantio share E-Mail
Other
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Web-Enabling Patients

m  Appointment > enter e-mail address in the E-mail field > check the W box
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m Patient Information > Options > Web Enable
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Erimany Cace Gliar

Frevious Hame [ Date of Buth. * [oerzarnses | Ages 37

Address Line 1/ [100 Man 5t SRV T e

Address Line T REOn. Aay
EN ) Sex'ff u|Famale [~ Transgender

City |'~l’u-:tbumu-;7n Wabdste Harital st,al'_unl.l j
statg [wa =] &P forso — Counteus of  social secunty ozoaaene Parenk infa |
Heme Phone [cos-gse-sess Cell Mo - - Emploger Hame [ECLINIEALWORKE - | Cleae] |
Wark Phane [ - - Ext [su7a g Emp Status [~ | (Hone Selocted)
{statements will be addressed to responsible party} Student States [~ ~| {nans Selectsd)
Responsible Party _Select | Set Ermergency Contact | Family Hub | Selsct] Remove |
Serath, Bonnee Emiérgenoy Conkact
Hame
: . doct Balance ELHB.SD E.lml l.']i. B.II
FotaGon [ | Self - patient is the insured Patient [Tasos  L_Ace Inguin
Last Appt [10/03/2083 11:00 AM Mot Anpt |
- Insurances IE | e t-:ul
gmﬂa Schedule | Fee mm:[m“ Test fun =\ Self Pay '_E | =] L[adal.g"] Remove |
]
Release of Information f‘f_" J =]
R Higtory Consent |_ "l Sean |
Signaturs Date =
Advance Cirective | =
addtional oo | =]  talee | Mseinte | psac | oK Caneal
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Recording E&M Codes

m  Progress Notes > Visit Code > Add E&M
I

8 tidos ik Procedure Code add cPT | Remove| EM Coder| medicare Edits | ¥ Pop Up
illinig H T = T I R
[CPT  [Wame gnesimy/mzimalmal  co: [ ooz | o3 ICO4  |Notes
Visit Code: ) . 99713 Office Visit, Est Pt., 1.00 1 25001 2  250.1%
» G0 Office Visit,

Procedurs Codas;

Sending Messages to Patients

Providers can send messages from the Patient Portal from the following location:

m Executable: Patient Hub > Send eMsg > enter information in the Subject and Message fields
or use an existing template > check the Preventive/Follow-up Care box > Send

From. Iw.l!is Carn Mudb AL ML,
To IlIJ:_-I:l,T-.-st: Abrecopy. my Agarwal Riya; ajay;ajay; aTest,Rashmi; 8.8 beingbidler: Billing Bl
subject |
l!-‘ Preventive/ Follow-up care muq:[

=T

| Load J Saye J “Save As |

x Ih @ 8 r U EE 3T oy Cu il . Sz s -

Fend Zancel
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m  Browser: Patient Hub > Send Message > check the eMessage box in the Choose Modality
section > enter information in the Subject and Message fields or use an existing template >
check the Health Maintenance box > Send

Patiert Portal / Healow App + Add # Edit

Subject

Message

g B » +||B I U|E & & 8

Heaisn Mainuenanct

ey

g

Total Patients: 1
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m Executable: Patient Hub > New Web Enc > select an option from the Reason drop-down list >

enter information in the Action Taken field > Reply to Patient > enter information in the
Subject and Message fields or use an existing template > check the Preventive/Follow-up Care
box > Send

w Fortal eMsg E3

From |WillisSam Multi A, M.O.

‘To |lIJ:-I:I.T-.-st: Abrecopy. my Agarwal Riya; ajéy;ajay; aTest,Rashmi; 8.8 beingbiller: Billing Bl

subject |

I w Pm:nuuﬂﬂ Follow -up care mu-!u|

' Load J Save J -Emraﬂsl

=

x b ® B I U EEFT w0l Fioes B

Send Lancel
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m  Browser: Patient Hub > New Web Enc > select an option from the Reason drop-down list >
Reply to Patient > check the eMessage box in the Choose Modality section > enter
information in the Subject and Message fields or use an existing template > check the Health
Maintenance box > Send

Paticn Foreal [ Hedan b +add || Edi

Healin blampenands

Tatal Patients: 1 & _|
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m Executable: Registry band > Lookup Encounters > set the filters and click Filter > check the
Show Unique Patients box > Lookup > check the boxes next to the patients to whom you
want to send a message > Send eMsg > enter information in the Subject and Message fields
or use an existing template > check the Preventive/Follow-up Care box > Send

w . Porbal eiisg EHT
From |Willis,Sam #ulti A, MO
To ]wcu.ra;t; Abrecopy gy Agarwal Riva) ajay,aisy; aTestRashmi; B.B; beirng.biller: Billing, Bl
Subject |

W Preventivef Follow-up care mﬂngu]

- Templates
Load I Saye | Save fs |
¥ @ B r g EEITE o Cu Gisees &
Zend ancal
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m  Browser: Registry menu > Lookup Encounters > set the filters and click Filter > check the
Show Unique Patients box > Filter > check the boxes next to the patients to whom you want
to send a message > Send Message > check the eMessage box in the Choose Modality
section > enter information in the Subject and Message fields or use an existing template >
check the Health Maintenance box > Send

v |

Pattert Portal / He e
Subject
Message

I & - B i U\ g = &=
A

Heslsh Mginsenance

Tatal Patients : 1 ;cpd ._
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m Executable: Registry band > Lookup Encounters > Blast eMsg > Yes > enter information in
the Subject and Message fields or use an existing template > check the Preventive/Follow-up
Care box > Send

w  Portal eiisg

From |#illis,Sam Sulti A, MO
To ILDDD.Ts-;t; Rboicopy g Agarweal Riva) afaysaiay: aTastRashimi; 8.8 beingbillery Billing, Sl
Subject |

I!E Preventivef Fulhn-ugxuu.mnngq
-~ Templates

Load I Saye | $a*¢-ﬁsJ

X D ® B r U EE I T Cca s oSS
Zend Zancel
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m  Browser: Registry menu > Lookup Encounters > Blast eMsg > Yes > check the appropriate
boxes in the Choose Modality section > enter information in the Subject and Message fields
or use an existing template > check the Health Maintenance box > Send

atiert Portal [ Healow Asp =+ Add 2 Edit

Heaiin biamienanid

Total Patients: 1

gL
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m Executable: Registry band > Registry icon > Demographics tab > set the filters > select Web
Enabled from the Select drop-down list > Run New > Encounters tab > set the filters > Run
Subset > check the boxes next to the patients to whom you want to send a message > Send
eMsg > enter information in the Subject and Message fields or use an existing template >
check the Preventive/Follow-up Care box > Send

From. |'--’-"is.-_1-;rn Wb, M.D
To ]u]:--:u.|-._.¢:-,-..::-:.ccl; T Adarial Ry Siay.Aiay: aTest Rachimi: BB being.biller: Siling, Sl
Subject |

W Preventivef Follow-up care message|

- Templates
Load I Saya I Save A |
¥ D@ 8 r U EEZD w0 Cuoal - Ses =

Send Zancsl
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Browser: Registry menu > Registry icon > Demographics tab > set the filters > select Web
Enabled from the Select drop-down list > Run New > Encounters tab > set the filters > Run
Subset > check the boxes next to the patients to whom you want to send a message >
Messenger > check the eMessage box in the Choose Modality section > enter information in
the Subject and Message fields or use an existing template > check the Health Maintenance
box > Send

B Fr Y
Parient Portal / Healow Agg + Add # Edit
Subject
Message
i W B8 - B I U\ = &=
¥
Healin hblamienanis
Total Patients: 1 [ Send |
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Replying to Secure Messages from Patients

m T quick-launch link > Web Encounter > click link in Patient column > Reply to Patient > check
the Preventive/Follow-up care message (executable) or the Health Maintenance (browser) box >
enter a message > Send

Executable:

r Answered by
[Wiltss, S, Muti

From |¥illeSam M
| Te 1

. Subject Il‘.E:Uanﬁ-Dﬂm on Medication mstruchaons

Patient

L

COBIE0/1I8/1958 Age: 23T Sex:F
Tel: 774-545-0547

Acct Mo:5162, WebEnabled: Tes
ERgl Sislus:

IF-" Preventive, Follow-up care mmme]
Templates

icam- tood | saye | sovess |
Reason Assigned D@ e sy EE ST )On A = Smed -
[ianiicatian on Medication instruction » | [wilis, =&
[T Perform Eligibility Check | N
Hessape | mx | Labs/D1 | Motes | Addendum | Log H. E o
Hessng ase take the medication twice a day. Once in the momang and once in the

. anng. If you have any further questons, please contact our office,

How many times & day bo take Metfarmin

Thank you,
Westborough Family Practice

Action Taken

[Tsers | conen |

Browser:

b s A
N Preview Message w

Patient Portal / Healow App | + &dg [l AEdit |

Subject

Message
X G B E s ~|B I ulle=as

Heaizh Maingenanie

Tatal Patients : 1 Sand
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Importing Questionnaire Answers from the Patient Portal

m  Progress Notes > click healow™ Hub icon at top of window (red square bracket with
downward-facing arrow) > click Import Current Page to import all answers or click a
download icon (downward-facing arrow) next to an answer to import just that answer

i)

L e e sy o wie e (EETDY | wcormenaiioss ing Vg WOt - SRCUES MOTTS i nsow -

[ Apalr DT R TA) koo B 8200 -

& Trwew fa G TOM WAANER e et o
S Fut 000

= -

At Bing Alvtt s E Lo

1] Chickis Trackers Exterral Health Restros

GQuestionnaires

Sur gl AR SA e Pirase £l out your Sergicst Hisory
o, i [Pience enter WORE o you hive nat had any surgery]
(Pages:

Surgery Date
e DAL 2018
Pieate Byt sy hospilizaton that are noz included in surgsce] hisony

Hospluatization ace

My OV ORINE

Pleise B pour slargy infarmation [ ng known alltvgy please erser HONE]

v Revenes || @ Been
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Review healow Hub Tracker Data

m  Progress Notes > click the healow™ Hub Tracker icon (blue zig-zag arrow)

= Lo wm my w0 owo won EETT  paimenibmeme e Lereac WGTES HEU Mo Do H oo
= i - N —— ﬁ".fﬂmm AR UL L 1

St 7 days i Pt A cays

Wi Shepe
G0N0 L

Ky SEmod

s

LD

dk

o
iF Fal 19 Fabr
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Logging In to the Patient Portal

m  Web browser > URL > enter information in Username and Password fields > Sign In > view a
Visit Summary or PHR record

health
Zportal

Welcome

healo
| Aok vont bealih records 1h rougl ihe Brabrn malild app

-

MEDICAL RECORDL

Ehqieen PEUE Hebing

Ertuest PRE

by bl Sl ard
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Downloading PHRs or Visit Summaries

m Patient Portal > Request PHR or View Medical Records > set date range > Submit

health

o [T WpETTer Toem Carnt=p m [ 25Asd Practce Hgoits Sy s
#portal
Hi Tom
i [ T
|- 4 [ - )
6 ® - a
CURRENT MIEDICATION RECENT REFERRALS MEDICAL RICORDE

* Rreitor

¥y e Flarothuide

-':r.-:.:l:mm
m Patient Portal > Medical Records > Personal Health Record > set date range > Submit
health
Zportal

B
My A court
|

MarLege

|_‘;.| Ferscnal Heakh Record
Mledical Recsids

Garrate health regord for date range of

Froam Daje: ® F Ty Dt ®

Dischaimar; The foliow g SeCtions fepresent 198 mosh Dment daa onracord with your provides(s) and are mot specific v the date range you have selected

Demagraphics, Smahong Status, Prodlems, Medications, Adlgegies, IFmmunirabans, Health Concarnns, and U0l

Cance] Submiit
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Objective 6: Coordination of Care Through Patient

Patient Portal > Medical Records > Visit Summary tab > Visit Summary button next to the

desired visit summary

health
Zportal

Hi Tom,

Walcome to Patient Portal

Personal Health Record

Visit Summary

‘% VISIT SUMMARY

All

Date Range

P 02/19/2018
(@ 10:00 AM

% 011222018
(@ 02:00 P

Reason | Visit Summaiy
Reasan
tin b prov 2 [ Visit Summary
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Transmitting Health Information

Patient Portal > Request PHR or View Medical Records > set date range > Submit > Share

health ki B Pl Fh S B
Fportal .
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Thary Pty roel o Mo e 1 g - (34

P FoiB i Pyt B bbb 1P

At i, e [P, ALl [y i

Fatued P [T Y P T o
LTI 9
Y
v b
B i
Coriact imfe
AFolrired b oL Aok

Patient Portal > Medical Records > Personal Health Record > set date range > Submit > Share

health
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m Patient Portal > Medical Records > Visit Summary tab > Visit Summary button > Share

health
Zportal

Rt as PR Denfprogd (LG - #sPient

Important: Please note only data that has clinical mapping will be shared trapsmiteed.

The folidmeng sacfsons represent the miss curent data oo redodd and & ool specific bo the date oF the Visit Dentographics, Smoking $tatus, Problems, Alerpies,
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Objective 7: Health Information Exchange (HIE)

Objective

The EP provides a summary of care record when transitioning or referring their patient to
another setting of care, receives or retrieves a summary of care record upon the receipt of a
transition or referral or upon the first patient encounter with a new patient, and incorporates
summary of care information from other providers into their EHR using the functions of CEHRT.

The following sections are related to objective 7:
m Health Information Exchange (HIE) Measures
m Direct Messaging Services with eClinicalWorks

m Features Related to HIE

Health Information Exchange (HIE) Measures

Providers must attest to all three of the following measures and must meet the threshold for at
least two measures to meet the objective:

m HIE 1: Send Summary of Care
m  HIE 2: Request/Accept Summary of Care

m  HIE 3: Clinical Reconciliation

HIE 1: Send Summary of Care

Measure

For more than 50 percent of transitions of care and referrals, the EP that transitions or refers
their patient to another setting of care or provider of care must perform ALL of the following:

m Create a summary of care record using CEHRT

m Electronically exchange the summary of care record
The following sections are related to HIE 1:

m  HIE 1 Denominator Criteria

m  HIE 1 Numerator Criteria

m HIE 1 Exclusion Criteria
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HIE T Denominator Criteria

Referrals are included in the denominator if they satisfy ALL of the following criteria:

Denominator
Criteria

Area to Document within eClinicalWorks

The EP was the
transferring or
referring
provider where
an outgoing
referral has
been printed,
faxed, or
transmitted
electronically
using JTN (Join
the Network)
during the PI
reporting
period

(continued on
next page)

Record this information from at least ONE of the following locations:

m  Progress Notes > Treatment > Outgoing Referral > Send Referral > Print,
Print with attachment(s), Fax, or Fax with attachment(s) (Denominator
Criteria Only)

m  Progress Notes > Treatment > Outgoing Referral > green arrow next to
the Send Referral button > Send Electronically

m  Progress Notes > green arrow next to Fax button > Fax Consult Notes
(Denominator Criteria Only)

m  Progress Notes > Send > eTransmit

m  Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing
Referral > Send Referral > Print, Print with attachment(s), Fax, Fax with
attachment(s), or green arrow next to the Send Referral button and
Send Electronically (Denominator Criteria Only)

m  Patient Hub > Referrals > Outgoing > New > Send Referral > Print, Print
with attachment(s), Fax, Fax with attachment(s), or green arrow next to
the Send Referral button and Send Electronically (Denominator Criteria
Only)

m T quick-launch link > Send eCW P2P Patient Record

m T quick-launch link > Send eCW P2P Referral/Consult

Note: Fax consult notes and/or referrals sent from within the same
database can be excluded from this denominator using settings on the
MAQ Dashboard:

aCh‘nr’caM

MIALCK Py

Prowlder Suitligs Pracilcs Seffings

Exclade Outgaing Referals sent 1o peoviders within the sane o linicalWerks database lor te denonimater calclations of the
Sunumary of Cane measure (Stage 3= Core-1%) and the Transition of Care Sumnsary nssaiure [Stage 1: BRR-3041]

Exclude "Fas Consull Notes™ Trom the deiommnator calloulsi ol ihe § ol Cane i5tage 1: Core-15) and the R
T of Eare % ¥ {Stage 1: 0E1-3041) Tem hiz

These should only be excluded if the fax consult notes are used for
purposes other than transition of care.

IMPORTANT! Referrals are only counted for a provider if they are listed as
the Referral From provider on the referral.
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Objective 7: Health Information Exchange (HIE)

Denominator

Area to Document within eClinicalWorks

Criteria
(continued IMPORTANT! If the Referral To specialty is mapped to community specialty
from previous Diagnostic Radiology or Pharmacy, those referrals are excluded from the
page) denominator for all practices and all providers.

If Pharmacy is not an option in the community mapping specialty section,
contact eClinicalWorks Support.
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HIE T Numerator Criteria

Referrals that satisfy the denominator are included in the numerator if they satisfy ALL of the
following criteria:

Numerator Criteria Area to Document within eClinicalWorks
They have had a summary of Record this information from at least ONE of the following
care record created using locations:

CEHRT and exchanged m  Progress Notes > Treatment > Outgoing Referral > green
electronically through P2P arrow next to the Send Referral button > Send

portal with the CCR/CCD Electronically

attached

m  Progress Notes > Send > eTransmit
m T quick-launch link > Send eCW P2P Patient Record
m T quick-launch link > Send eCW P2P Referral/Consult

IMPORTANT! For electronic transmission of summary of
care records, referrals must be sent via Join The Network
(JTN).

JTN is an initiative to connect providers to one of the
largest vendor-neutral networks in the country. Join The
Network or get your Direct Address (Option 2) to send and
receive referrals electronically for Promoting
Interoperability. For more information, refer to Requesting
a Direct Address.

To meet this measure, invite other providers to JTN and
send referrals electronically.

If other providers are not on JTN, request a HISP-HISP
interface. Please open a support case to initiate HISP- HISP
interface.

IMPORTANT! The check box for verifying Allergies, Current
Medications, and Problem Lists must be checked in the
patient's most recent Progress Notes before sending the
patient record or referral.An EC must verify and record
current medications, current medication allergies, and the
current Problem List in the patient's most recent Progress
Notes before sending the referral or patient record.

If a patient does not have any known medication allergies,
the N.K.D.A. box must be checked in the Allergies section of
the Past Medical History window.

(continued on next page) If a patient does not have any known problems, the N.K.P.
box must be checked on the Problem List window.
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Numerator Criteria Area to Document within eClinicalWorks
(continued from previous IMPORTANT! A CCR/CCD MUST be attached to satisfy the
page) numerator. Click the Attachments button when sending

referrals to ensure a CCR/CCD is attached.

Note: ICD codes in the Problem List must be mapped to
SNOMED CT codes.

Note: The date the referral was actually transmitted must
be within the PI measurement period to be included in the
numerator.

If other providers are not on JTN, request a HISP (Health Information Service Provider) interface:

m  Option 2: If the receiving provider is on a HISP that is part of the Direct Trust Bundle,
request a Direct Address through Option 2.

& Receive a Direct Address signed by third-party vendor DigiCert through this option.
¢ The HISP-HISP connection is established through eClinicalDirect HISP.
¢ eClinicalDirect is fully accredited by EHNAC and is part of the Direct Trust Bundle.

Note: eClinicalWorks Direct (Option 1) to issue a direct address is no longer available.

HIE 1 Exclusion Criteria

Providers may be excluded from this measure if they satisfy at least ONE of the following

criteria:
Exclusion Criteria Area to Document within eClinicalWorks
They transferred patients to This exclusion criterion is reported by self-attestation.

another setting or referred
patients to another provider
less than 100 times during
the Pl reporting period

They conduct 50% or more of | This exclusion criterion is reported by self-attestation.
their patient encounters in a
county that does not have
50% or more of its housing
units with 4 MBPS broadband
availability, according to the
latest information from the
FCC on the first day of the PI
reporting period

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018 117



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 7: Health Information Exchange (HIE)

HIE 2. Request/Accept Summary of Care

Measure

For more than 40 percent of transitions or referrals received and patient encounters in which
the provider has never before encountered the patient, the EP incorporates into the patient’s
EHR an electronic summary of care document.

The following sections are related to HIE 2:
m HIE 2 Denominator Criteria
m  HIE 2 Numerator Criteria

m HIE 2 Exclusion Criteria

HIE 2 Denominator Criteria

Encounters are included in the denominator if they satisfy ALL of the following criteria:

Denominator
Criteria

Number of patient Record this information from the following location:
encounters during m Practice > Resource Scheduling or provider's schedule icon > open

Area to Document within eClinicalWorks

the Pl reporting an existing appointment (by double-clicking on it) or create a new
period for which appointment (by double-clicking on an open time slot or right-

an EP was the clicking on an open time slot and clicking New Appointment) >
receiving party of Transition of Care > check the Transition of Care - Electronic
transition or summary of care record received or Transition of Care - Electronic
referral or has summary of care record NOT received box > if the first box is
never before checked, select an incoming referral or P2P patient record > OK
encountered the m  Progress Notes > Chief Complaints > Transition of Care > check the
patient and for Transition of Care - Electronic summary of care record received or
whom an Transition of Care - Electronic summary of care record NOT received
electronic box > if the first box is checked, select an incoming referral or P2P
summary of care patient record > OK

record is available X — X
Note: Checking the Transition of Care - Electronic summary of care record

NOT received box in excludes patients from denominator calculations.

Note: If an electronic (P2P®) incoming referral or patient record has
not been sent to the practice/provider, there will not be a referral/
patient record on the Transition of Care window to map to an
appointment/encounter.

For more information, refer to the Sending and Receiving P2P Referrals
section of the eClinicalWorks P2P Users Guide.
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HIE 2 Numerator Criteria

Objective 7: Health Information Exchange (

HIE)

Encounters that satisfy the denominator are included in the numerator if they satisfy ALL of the

following criteria:

Numerator Criteria

Area to Document within eClinicalWorks

Number of patient
encounters in the
denominator where an
electronic summary of care
record received is
incorporated by the provider
into the CEHRT

Progress Notes > click the DRTLA tab in the ICW pane on
the right > click the CCR link for a referral > click the blue
arrow icon next to Problem List, Allergies, or Medication
information to import it from this referral into the open
Progress Notes

Note: A record is NOT considered incorporated if it is
discarded without the reconciliation of clinical information,
or if it is stored in a manner inaccessible to providers within
the EHR.

HIE 2 Exclusion Criteria

Providers may be excluded from this measure if they satisfy at least ONE the following criteria:

Exclusion Criteria

Area to Document within eClinicalWorks

They have less than 100 total
transitions of care or
incoming referrals for
patients they have not
encountered before

This exclusion criterion is reported by self-attestation

They conduct 50% or more of
their patient encounters in a
county that does not have
50% or more of its housing
units with 4 MBPS broadband
availability, according to the
latest information from the
FCC on the first day of the PI
reporting period

This exclusion criterion is reported by self-attestation
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HIE 3: Clinical Reconciliation

Measure

For more than 80 percent of transitions or referrals received and patient encounters in which
the provider has never before encountered the patient, the EP performs a clinical information
reconciliation. The provider must implement clinical information reconciliation for the following
three clinical information sets:

m  Medication - Review of the patient’'s medication, including the name, dosage, frequency, and
route of each medication.

m  Medication Allergy - Review of the patient’'s known medication allergies.

m  Current Problem List - Review of the patient’s current and active diagnoses.
The following sections are related to HIE 3:

m  HIE 3 Denominator Criteria

m  HIE 3 Numerator Criteria

m HIE 3 Exclusion Criteria
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HIE 3 Denominator Criteria

Referrals are included in the denominator if they satisfy ALL of the following criteria:

Denominator

Area to Document within eClinicalWorks

transition or
referral or has
never before
encountered
the patient

Criteria
Number of Record this information from at least ONE of the following locations:
transitions of m  Practice > Resource Scheduling or provider's schedule icon > open an
care or existing appointment (by double-clicking on it) or create a new
referrals appointment (by double-clicking on an open time slot or right-clicking
during the PI on an open time slot and clicking New Appointment) > Transition of
reporting Care > check the Transition of Care - Electronic summary of care record
period for received or Transition of Care - Electronic summary of care record NOT
which the EP received box > if the first box is checked, select an incoming referral or
was the P2P patient record > OK
recipientofthe | g progress Notes > Chief Complaints > Transition of Care > check the

Transition of Care - Electronic summary of care record received or
Transition of Care - Electronic summary of care record NOT received
box > if the first box is checked, select an incoming referral or P2P
patient record > OK

Note: Patients are included in this denominator if either the Transition of
Care - Electronic summary of care record received or Transition of Care -
Electronic summary of care record NOT received box is checked.

Note: If an electronic (P2P®) incoming referral or patient record has not
been sent to the practice/provider, there will not be a referral/patient
record on the Transition of Care window to map to an appointment/
encounter.

For more information, refer to the Sending and Receiving P2P Referrals
section of the eClinicalWorks P2P Users Guide.
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HIE 3 Numerator Criteria

Referrals that satisfy the denominator are included in the numerator if they satisfy ALL of the

following criteria:

Numerator Criteria

Area to Document within eClinicalWorks

The number of transitions of
care and referrals in the
denominator where the
following three clinical
information reconciliations
were performed: medication
list, medication allergy list,
and current Problem List

Record each of the following categories of information to
satisfy this criterion:

Record medication list information from the following

location:

& Progress Notes > Current Medication > check the
Verified box

Record medication allergy list information from the

following location:

¢ Progress Notes > Allergies/Intolerance > check the
N.K.D.A box or add allergies and check the Allergies
Verified box

Record Problem List information from at least ONE of

the following locations:

¢ Progress Notes > Assessments > check the box(es) in
the PL column for all ICD codes you want to add to
this patient’s Problem List

¢ Progress Notes > Assessments > Problem List > check
the No known problems box

& Progress Notes > from the Overview tab in the ICW
pane on the right, click the ellipsis button in the
Problem List heading > check the No known
problems box

& Progress Notes > Assessments > check the box(es) in
the PL column for all ICD codes you want to add to
this patient’s Problem List > PL Verified

IMPORTANT! The PL Verified button displays in red if the
Problem List has not been verified.

Clicking the PL Verified button prompts you to conduct a
review of the patient's current Problem List. Once the
Problem List has been verified, this button turns from red
to green.
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HIE 3 Exclusion Criteria

Providers may be excluded from this measure if they satisfy at least ONE of the following

Objective 7: Health Information Exchange (HIE)

criteria:
Exclusion Criteria Area to Document within eClinicalWorks
They have less than 100 total This exclusion criterion is reported by self-attestation

transitions of care or
incoming referrals for
patients they have not
encountered before

Direct Messaging Services with eClinicalWorks

eClinicalWorks offers Direct Messaging Services with the eClinicalDirect HISP (Option 2):

eClinicalWorks has formed a subsidiary, eClinicalDirect, to connect to the accredited Direct

Trust Bundle.

The Direct Address issued to providers is signed by a third-party vendor, DigiCert®.

Providers can request their Direct address by choosing Option 2 under the P2P setting in

eClinicalWorks EMR/PM solution.
This option is fee-based, as there is the involvement of a third-party, DigiCert.

Note: eClinicalWorks Direct (Option 1) to issue a direct address is no longer available.

Features Related to HIE

T
]
]

he following features are related to the health information exchange:
Sending Referrals
Recording E&M Codes
Recording Receipt of Documentation of Summary of Care
Recording Medication Reconciliation
Recording Allergies Reconciliation
Recording Problem List Reconciliation

Incorporating Summary of Care Information into Progress Notes
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Sending Referrals

m  Progress Notes > Treatment > Outgoing Referral > Send Referral > Print, Print with
attachment(s), Fax, or Fax with attachment(s) (Denominator Criteria Only)
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m  Progress Notes > green arrow next to Fax button > Fax Consult Notes (Denominator Criteria
Only)

Progress Notes -

SECURE NOTES

7 Progress Notes & Scribe 1B Orders L Quick Search 2T
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m T quick-launch link > Send eCW P2P Patient Record
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© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018

Telephone/Web Encounter > Virtual Visit > Treatment > Outgoing Referral > Send Referral >
Print, Print with attachment(s), Fax, Fax with attachment(s), or green arrow next to the Send
Referral button and Send Electronically (Denominator Criteria Only)
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m Patient Hub > Referrals > Outgoing > New > Send Referral > Print, Print with attachment(s),
Fax, Fax with attachment(s), or green arrow next to the Send Referral button and Send
Electronically (Denominator Criteria Only)
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Recording E&M Codes

m  Progress Notes > Visit Code > Add E&M
I
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Recording Receipt of Documentation of Summary of Care

Use one of the following paths to access the Incoming Referrals/Patient Records window and
document the receipt of the transition of care:

m Practice > Resource Scheduling or provider's schedule icon > open an existing appointment
(by double-clicking on it) or create a new appointment (by double-clicking on an open time
slot or right-clicking on an open time slot and clicking New Appointment) > Transition of Care
> check the Transition of Care - Electronic summary of care record received or Transition of Care
- Electronic summary of care record NOT received box > if the first box is checked, select an
incoming referral or P2P patient record > OK

m  Progress Notes > Chief Complaints > Transition of Care > check the Transition of Care - Electronic

summary of care record received or Transition of Care - Electronic summary of care record NOT
received box > if the first box is checked, select an incoming referral or P2P patient record >
OK

Incaming ReferralurPalient Records £

Patisrt: Hig 1. Panent 14

I o, Transifion of Care - Eectends sumamary ¢f Care rederd sotthed I
Transition 6f Care - Electroms sumanary of Care record ROT receied

- ET
Date Beatam Refersal From Pelerral Ta rasrpredie Speclalicy Lrast Date Eme Draga
PR SlEvItE SIS |
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Note: When a referral/patient record has been mapped to an appointment/encounter on the
Transition of Care window, it displays on the Appointment window to notify you:
N Appointment
F-ﬂflii"r.!" 1.1;2,51: b&raugh E»tﬁ'dl- Y PDS 1 Pl‘cwid!r' -
Date*  ncig1iz018 ™ Claim Provider Resource* =
Time* | 5900 am - 015 am - Email Web Enable
N Visit Referral No: Date : 5t Dt: 0472272018 End Dt; 06/19/2019
VisitType* @ Migrated (Migrated) * O Ress0n | Ervar
VisitStatus 1 pEn (Pending) - Diagnosiz
= v Transition Of Care |
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Recording Medication Reconciliation

Progress Notes > Current Medication > check the Verified box

Progress Notes . -
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Recording Allergies Reconciliation

Objective 7: Health Information Exchange (HIE)

Progress Notes > Allergies/Intolerance > check the N.K.D.A box or add allergies and check the

Allergies Verified box

Allergies Browse Rx... | % Add | = Remove | Allergy Log | ¥ NKD.A [V ABerges Verified

Agent/Substance iReaction  |Type |Status | Criticali| Onset Date
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Recording Problem List Reconciliation

Objective 7: Health Information Exchange (HIE)

m  Progress Notes > Assessments > check the box(es) in the PL column for all ICD codes you

want to add to this patient’s Problem List

| Pt.info Encounter Physical i Hub Education

|0 PD@Ms R ARARD LHHEL BALFE B inEB |

v Mo

Assessment “ o0 Seacch Assessments
Previous Assessments L
Pigblzm List
fzzezzments
& Cardiology
IO Dby GEMS Impost
Ingenix ICDY Codes

1o ICD10 [ Defadt

m  Progress Notes > Assessments > Problem List > check the No known problems box

| Pt.info Encounter Physical i Hub Education
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DOB: 10/18/1994 Age: 23 Y Sex: Fermnale
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© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018

e —
|':Ellﬂ*_i'

Dx Type IAIIDx -| Clinical Status [Al

[Name [Specify

| [FF M krown pwbrmsl
~[Notes i

131



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018 Objective 7: Health Information Exchange (HIE)

m  Progress Notes > from the Overview tab in the ICW pane on the right, click the ellipsis button
in the Problem List heading > check the No known problems box

~ UpToDate” | |

Overview DRTLA History ‘ CD5S5 Order Sets Lab=/D

- 3} ]IJ.,I—-l [ ai
ight Panel data Iast modified on: 10/10/2017 03:26 PM
B Global Alerts

Patient : Nguyen, Mai

Problem List
Dx Type |All Dx =] Clinical Status [all =] |¥ Mo known problems

Onset Date

m  Progress Notes > Assessments > check the box(es) in the PL column for all ICD codes you
want to add to this patient’s Problem List > PL Verified

| Pt. Info Encounter Physical ﬁ Hub Education
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Assessment ICD-10-CM Bl Map ko ICD10 ™ Default
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Objective 7: Health Information Exchange (HIE)

Incorporating Summary of Care Information into Progress Notes

m  Progress Notes > click the DRTLA tab in the ICW pane on the right > click the CCR link for a
referral > click the blue arrow icon next to Problem List, Allergies, or Medication information
to import it from this referral into the open Progress Notes

Overview | DRTLA | History | CD5S | Order Sets | Labs/DI |

1 : ke
+ ‘Nguyen, Mai 23°Y, F as of 12/05/2017

Right Panel data last modified on: 10/10/2017 03:26 PM

|Last 3months V|

B Labs All

4| Diagnostic Imaging &Y

H Procedure All

4
g
4

B Telephone Encounters

B web Encounters
B Scenario 2.3 tin B provider
= | Message to Tin BY Provider

H Referrals
ﬂ Scenario 1.3 Tin B Proy

Scenario 1.3 Tin B Prov
CCR

& 0 Scenario 1.3 Tin B Proy
CCR

Problem List

Allergies
N.K.D.A

Medication o

Active Medications{Medications with..)

Amoxicillin 250 MG 1 capsule
(Amoxicillin) Orally every 8 hrs
Morco 10-325 MG 1 tablet as needed
(Morca) Crally every 6 hrs

Cipro 250 MG 1 tablet Orally every
{Cipra) 12 hrs

5-400 M5 1 tablet as
needed Orally every
g hrs

Oxycodone-Ibuprofen
(wycodone-Ibuprofen)

© Copyright eClinicalWorks, April 2019 - Promoting Interoperability (PI) Stage 3 for Medicaid EPs in 2018

133



Promoting Interoperability Stage 3 Objectives for Medicaid EPs in 2018

Objective 8: Public Health & Clinical Data Registry

Objective 8: Public Health & Clinical Data Registry Reporting
(PHCDRR)

Objective

The EP is in active engagement with a public health agency or clinical data registry to submit

electronic public health data in a meaningful way using certified EHR technology, except where
prohibited, and in accordance with applicable law and practice.

IMPORTANT! In order to meet this objective, EPs are required to meet two (2) out of five
(5) of the measures available to them. An exclusion for a measure does NOT count toward
the total of two measures.

The following sections are related to Objective 8:

Public Health & Clinical Registry Reporting 1: Immunization Registry Reporting
Public Health & Clinical Registry Reporting 2: Syndromic Surveillance Reporting
Public Health & Clinical Registry Reporting 3: Electronic Case Reporting

Public Health & Clinical Registry Reporting 4: Public Health Registry Reporting
Public Health & Clinical Registry Reporting 5: Clinical Data Registry Reporting
Features Related to Public Health & Clinical Data Registry Reporting

Public Health Report Auditing

Patient Encounter Report

Public Health & Clinical Registry Reporting 1: Immunization

Regis

try Reporting

Measure

The EP is in active engagement with a public health agency to submit immunization data and
receive immunization forecasts and histories from the public health immunization registry/

immunization information system (lIS).

Note: At a minimum, you must register with your registry within the first 60 days of the
start of the reporting period and follow their testing procedures.

IMPORTANT! No denominator/numerator calculations are required for this measure. This
measure is reported through self-attestation.
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Objective 8: Public Health & Clinical Data Registry

Features Area to Document within eClinicalWorks
Ongoing submissions EMR > Immunizations/Therapeutic Injections >
originally achieved in a prior Immunizations Registry > Export Immunizations

year using HL7 2.3.1 that are
continuing

A registration of intent within Contact your state immunization registry.

60 days of the beginning of Note: eClinicalWorks provides registry interfaces to

the reporting period and practices in many states. The process details vary slightly
meet at least ONE of the based on individual state requirements. Contact eCW
following criteria: Support for more information about an immunization

= Awaiting an invitation to registry interface for a specific state.

begin testing

m  Engaged in testing

m  Ongoing submissions
using HL7

Note: Medicaid-eligible providers must use the capabilities and standards of CEHRT at 45 CFR

170.315(f)(1). The standards include, but are not limited to, transmitting in HL7 version 2.5.1,
historic immunizations transmitted with CVX codes, and administered immunizations

transmitted with NDC codes.

Public Health & Clinical Data Registry Reporting 1 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria

Area to Document within eClinicalWorks

They do not administer any
immunizations to any of the
populations for which data is
collected by its jurisdiction's
immunization registry or
immunization information system
during the PI reporting period

This is reported by self-attestation.

They operate in a jurisdiction where
no immunization registry or
immunization information system
has declared readiness to receive
immunization data from the EP as of
six months prior to the start of the PI
reporting period

This is reported by self-attestation.
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Exclusion Criteria Area to Document within eClinicalWorks

They operate in a jurisdiction for This is reported by self-attestation.
which no immunization registry or
immunization information system is
capable of accepting the specific
standards required to meet the
CEHRT definition at the start of the PI
reporting period

Public Health & Clinical Registry Reporting 2: Syndromic
Surveillance Reporting

Measure

The EP is in active engagement with a public health agency to submit syndromic surveillance
data from an urgent care setting.

Note: At a minimum, you must register with your registry within the first 60 days of the
start of the reporting period and follow their testing procedures.

IMPORTANT! No denominator/numerator calculations are required for this measure. This
measure is reported through self-attestation.
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The following features are related to this measure:

Features Area to Document within eClinicalWorks
Ongoing submissions Each state has its own rules for syndromic surveillance.
originally achieved in a prior Please contact your state’s call center for more information.
year using HL7 2.3.1 that are Open a support case to determine the scope and the cost
continuing of an interface with your chosen public health agency.

A registration of intent within

60 days of the beginning of

the reporting period and

meet at least ONE of the

following criteria:

m  Awaiting an invitation to
begin testing

m  Engaged in testing

m  Ongoing submissions
using HL7

Note: Medicaid-eligible providers must use the capabilities and standards of CEHRT at 45 CFR
170.315(f)(2). The standards include, but are not limited to, transmitting in HL7 version 2.5.1.

Public Health & Clinical Data Registry Reporting 2 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks

They are not in a category of This is reported by self-attestation.
providers from which ambulatory
syndromic surveillance data is
collected by their jurisdiction's
syndromic surveillance system

They operate in a jurisdiction where This is reported by self-attestation.
no public health agency has declared
readiness to receive syndromic
surveillance data from EPs as of six
months prior to the start of the Pl
reporting period
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Exclusion Criteria Area to Document within eClinicalWorks

They operate in a jurisdiction for This is reported by self-attestation.
which no public health agency is
capable of receiving electronic
syndromic surveillance data from EPs
in the specific standards required to
meet the CEHRT definition at the
start of the PI reporting period

Public Health & Clinical Registry Reporting 3: Electronic Case
Reporting

eClinicalWorks is not supporting this measure at this time.

Public Health & Clinical Registry Reporting 4. Public Health
Registry Reporting
Measure

The EP is in active engagement with a public health agency to submit data to public health
registries.

IMPORTANT! No denominator/numerator calculations are required for this measure. This
measure is reported through self-attestation.

Providers must attest Yes to being in active engagement with a public health agency to submit
data to public health registries:

Criteria Action
An ongoing submission has already been achieved for an Note: CDC and any other
Pl reporting period in a prior year and continues registry that accepts CCDA via
throughout the current Pl reporting period. Data Portability are examples
A registration with the PHA (or other body to whom the that will help satisfy this
information is being submitted) of intent to initiate e
ongoing submission was made by the deadline (within 60
days of the start of the Pl reporting period) and ongoing
submission was achieved.
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Objective 8: Public Health & Clinical Data Registry

Criteria

Action

A registration of intent to initiate ongoing submission was
made by the deadline and the EP or hospital is still
engaged in testing and validation of ongoing electronic
submission.

A registration of intent to initiate ongoing submission was
made by the deadline and the EP or hospital is awaiting an
invitation to begin testing and validation.

Note: To register intent to
submit data to NCHS, please
go to the National Health Care
Surveys Registry Portal at:
https://hehr.nchs.cdc.gov/
providerportal/public/landing-
page.html

Public Health & Clinical Data Registry Reporting 4 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria

Area to Document within
eClinicalWorks

They do not diagnose or directly treat any disease or
condition associated with a public health registry in their
jurisdiction during the PI reporting period

This is reported by self-
attestation.

They operate in a jurisdiction for which no public health
agency is capable of accepting electronic registry
transactions in the specific standards required to meet the
CEHRT definition at the start of the Pl reporting period

This is reported by self-
attestation.

They operate in a jurisdiction where no public health
registry for which the eligible hospital or CAH is eligible has
declared readiness to receive electronic registry
transactions as of 6 months prior to the start of the Pl
reporting period.

This is reported by self-
attestation.

Public Health & Clinical Registry Reporting 5: Clinical Data

Registry Reporting

Measure

The EP is in active engagement to submit data to a clinical data registry.

measure is reported through self-attestation.

IMPORTANT! No denominator/numerator calculations are required for this measure. This
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Objective 8: Public Health & Clinical Data Registry

Providers must attest Yes to being in active engagement to submit data to a clinical data

registry:

Criteria

Action

An ongoing submission has
already been achieved for an
Pl reporting period in a prior
year and continues
throughout the current PI
reporting period.

A registration with the PHA
(or other body to whom the
information is being
submitted) of intent to
initiate ongoing submission
was made by the deadline
(within 60 days of the start of
the Pl reporting period) and
ongoing submission was
achieved.

A registration of intent to
initiate ongoing submission
was made by the deadline
and the EP or hospital is still
engaged in testing and
validation of ongoing
electronic submission.

A registration of intent to
initiate ongoing submission
was made by the deadline
and the EP or hospital is
awaiting an invitation to
begin testing and validation.

Identify whether your state or national specialty society
has a specialized registry.

If your state has a specialized registry, you must register
your intent within the first 60 days of the reporting
period.

If your state does not have a specialized registry, please
verify with your national specialty society to see if they
have or are sponsoring a specialized registry. If so,
register your intent within the first 60 days of the
reporting period with Dartnet.info (as this is our
preferred registry).

If neither your state nor your specialty society has a
specialized registry, you can claim an exclusion.

In cases where you cannot claim an exclusion from other
Menu Set Measures and you are not able to meet them
(e.g., you diagnose cancer and there is a cancer registry
in your state but you cannot meet the measure as eCW
is not supporting a cancer registry OR you have access
to imaging results but are not able to meet the measure,
i.e., access imaging results from CEHRT), then you should
satisfy this measure by registering your intent for on-
going submission within the first 60 days of the
reporting period with Dartnet.info.

For more information on Dartnet.info, refer to What is
DARTnet.info?.

Note: DARTnet is one example of a registry that will help satisfy this measure. Information
can be submitted to any registry that accepts CCDA and is managed by your state or local

jurisdiction.
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Public Health & Clinical Data Registry Reporting 5 Exclusion Criteria

Providers may be excluded from this measure if they meet at least ONE of the following criteria:

Exclusion Criteria Area to Document within eClinicalWorks

They do not diagnose or directly treat This is reported by self-attestation.
any disease or condition associated
with a clinical data registry in their
jurisdiction during the PI reporting
period

They operate in a jurisdiction for This is reported by self-attestation.
which no clinical data registry is
capable of accepting electronic
registry transactions in the specific
standards required to meet the
CEHRT definition at the start of the PI
reporting period

They operate in a jurisdiction where This is reported by self-attestation.
no clinical data registry for which the
eligible hospital or CAH is eligible has
declared readiness to receive
electronic registry transactions as of
6 months prior to the start of the PlI
reporting period

What is DARTnet.info?

The DI Practice Performance Registry compiles and processes EHR data in order to provide a
graphical view of how organizations and practices are doing on specific measures and how they
compare to other organizations/practices.

The DI Practice Performance Registry has been endorsed by the American Academy of Family
Physicians as a Quality Improvement Registry. It also meets Stage 3 Promoting Interoperability
Objective 10 - Measure 3 requirements, specifically: Successful ongoing submission of specific
case information from a certified EHR technology to a specialized registry for the entire Pl
reporting period.

Contact DARTnet by e-mail at DIRegistry@dartnet.info to register your intent. This process takes
several days to complete, so be sure to contact them as early as possible.
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Features Related to Public Health & Clinical Data Registry
Reporting

The following features are related to public health and clinical data registry reporting:

m  Exporting Immunizations

Exporting Immunizations

m  EMR > Immunizations/Therapeutic Injections > Immunizations Registry > Export
Immunizations
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Public Health Report Auditing

The following features are related to public health reporting:
m  Capability to Submit Electronic Data to Immunization Registry

m  Public Health Objective Exclusions

Capability to Submit Electronic Data to Immunization Registry

Some practices may be exempt from this measure.
If your state has an immunization interface with eClinicalWorks:

1. From the File menu, click Interface Dashboard.
2. On the Interface Dashboard window, click the Immunizations tab at the top of the window.
3. On the Immunizations window, click the Outbound tab on the left side of the window.
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4. Information on immunizations sent from this system displays:

Interface Dashboard
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Note: If it is necessary to go back further than one month, please contact
eClinicalWorks Support to obtain logs showing that data.

OR

m [f the data submissions failed through the Immunization interface, take a screenshot of this
failed submission.

m [f you submitted a test HL7 file, provide documentation from your state that your test was
successful or unsuccessful.

m |f you were unable to submit an HL7 file due to a state unavailability discrepancy, request
documentation for this from your state.

m [f your state registry is on a different HL7 standard than eClinicalWorks’ and you were not
able to send a test file, contact eClinicalWorks Support and we will provide you a letter
stating that we currently only offer HL7 version 2.5.1.

Note: Only the data for the last month is displayed on the Immunization Dashboard.
Any immunization from one to six months old is archived, for which we do not have
access.

Public Health Objective Exclusions

Beginning in 2014, EPs could not select a public health objective and claim exclusion for it if
there were other public health objectives they could meet.

Capability to Submit Electronic Syndromic Surveillance Data to Public Health Agencies

If you submitted a test HL7 file, provide documentation from your state that your test was
successful or unsuccessful.

If you were unable to submit an HL7 file due to a state unavailability discrepancy, request
documentation for this from your state.

If eClinicalWorks is on a different HL7 format than your state registry and you were not able to
send your test file, contact eClinicalWorks Support and we will provide you a letter stating that
we currently only offer HL7 version 2.5.1.
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Medicaid Promoting Interoperability

In addition to all the aforementioned requirements, Medicaid attestation requires the Patient
Encounter Report. Since eClinicalWorks can generate only the number of patients seen using
the eClinicalWorks application, if any patient was seen using a paper chart or at another facility,
that number must be manually added to the denominator. If the practice has used the
eClinicalWorks application only, the numerator would match the denominator for both of the
following reports.

IMPORTANT! These are state-specific requirements. Practices should check with their
states for specific Medicaid Promoting Interoperability requirements.

Patient Encounter Report

50% of All Patient Encounters Occurred at a Facility Using Certified EHR Technology

From Registry > Lookup Encounters, uncheck the Unique Patients box, then run the Patient
Encounter Report.

80% of All Unique Patient Encounters Occurred at a Facility Using Certified EHR Technology

Use the denominator of the Patient Electronic Access measure to get the numerator of this
report.
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PROMOTING INTEROPERABILITY STAGE 3 AUDIT
TOOLKIT

This document provides suggestions for eClinicalWorks clients to prepare for a potential
Promoting Interoperability audit. Auditors may need more information on a case-by-case basis.
In such circumstances, contact eClinicalWorks Support for additional assistance.

Promoting Interoperability Audits

Providers who receive an EHR incentive payment for Stage 3 of the Medicaid EHR Incentive
Program may potentially be subject to an audit. Eligible professionals (EPs) and eligible
hospitals should retain all relevant supporting documentation (in either paper or electronic
format) used in the completion of the Attestation Module responses.

Documentation to support attestation data for Stage 3 Promoting Interoperability objectives
and Clinical Quality Measures (CQMs) should be retained for six years post-attestation.

Overview of Promoting Interoperability for 2018

Medicaid EPs, regardless of past participation, must attest 90 consecutive days between Jan 1,
2018 and Dec 31, 2018.

To document proof of compliance for percentage-based measures:

1. As proof of use of a Certified Electronic Health Record Technology system, provide invoices
or a copy of your licensing agreement with the vendor. Please ensure that the licensing
agreements or invoices identify the vendor, product name, and product version number of
the Certified Electronic Health Record Technology system utilized during your attestation
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period. If the version is not present on the invoice/contract, please supply a letter from your
vendor attesting to the version number used during your attestation period.

Request an EHR verification letter by opening a case with eClinicalWorks Support. Indicate
the reporting period, stage on which you are reporting, and the number of providers on
which you are reporting:
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2. Provide a response to the following questions:

a. At how many offices or other outpatient facilities do you see your patients?

b. List each office or other outpatient facility where you see patients and indicate whether
or not you utilize Certified Electronic Health Record Technology in each office or other
outpatients facility:

b Office or Other Outpatient Facility Utilize CEHRTS?
1
2

3

¢. If you utilize more than one office or other outpatient facility, supply documentation
which proves that 50% or more of your patient encounters during the Pl reporting
period have been seen in offices or outpatient facilities where you utilize a CEHRT
system.
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d. Do you maintain any patient records outside of your CEHRT system?

If yes, supply documentation which proves that more than 80% of the medical records of
unique patients seen during the attestation period are maintained in a CEHRT system at
each office or other outpatient facility where CEHRT system is being used.

Attesting to Objectives

For Objectives 2, 4.1, 4.2,4.3,5.1,5.2, 6.1, 6.2, 6.3, 7.1, 7.2, and 7.3 provide the supporting
documentation (in electronic format) used in the completion of the Attestation Module
responses (e.g., a report from your EHR system that ties to your attestation). This
documentation should include the numerator and denominator for each objective, as well as
the date range and the EP's name or NPI.

Note: If you are providing a summary report from your EHR system as support for your
numerators/denominators, please ensure that we can identify that the report has actually
been generated by your EHR (e.g., your EHR logo is displayed on the report, or step-by-
step screenshots which demonstrate how the report is generated by your EHR are
provided).

To document proof of compliance for percentage-based measures:
1. From the MAQ Dashboard, click Stage 3 > Meaningful Use > 2018 Measure Set > Objectives:
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2. From the Select View drop-down list, click Score Card:

Practice Practice

(Threshold %}| Denominat

Period & | Period B

100 (30) 3993
94.42 (B0) 1182

OR

90.48 (30) 1083

Calendar Year
S90-Day

QTD

QTR

¥TD

| Yearly

=1k Select Provider{s) Score Card

Select View
Manthly

Score Card I

el okt

If data for previous years is required, click Historic View.

Attesting to Objectives

3. Click Period A or Period B to open the Select Any One Period window and select a time period:

Select Any One Period
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4. Export the data to a PDF by clicking the floppy disk icon to open a drop-down list, then

clicking Save as PDF:
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5. Save the file on your desktop.
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A message displays confirming that the file was saved successfully:

In the file that is saved on your computer, pages 1 and 2 display the Objective Measures for
the practice:
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Pages 3 and 4 display the Objective Measures for the selected provider:

eClinicalWorks
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Additional Tips

Throughout a Promoting Interoperability Stage 3 audit, keep the following tips in mind:

m [f you have referred to any FAQ from http://questions.cms.gov, keep a copy of that FAQ
document.

m  Provide supporting documentation for all claimed exclusions.
m Print the PDF Summary at the end of attestation and keep it on file.

m  When sending the screenshots to the auditors, black out any identifiable patient health
information. If this is not possible, use secure messaging to send the screenshots. Ensure
that all data sharing with the auditors is HIPAA compliant.

For more information about HIPAA compliance, visit: http://www.hhs.gov/ocr/privacy/
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APPENDIX A: DOCUMENTATION TERMS AND
CONDITIONS

Documentation: This document contains information that is confidential and proprietary to
eClinicalWorks, LLC and is intended for use solely by its authorized licensees ("Authorized
Entity"). In accordance with these conditions and contractual agreements by the user, this
document may not be copied, displayed, distributed, published, or otherwise reproduced,
otherwise used, transmitted, or in any form or otherwise made available or used by anyone
other than the authorized client to whom this document was originally delivered without the
prior written consent of eClinicalWorks, LLC. Pursuant to its agreement, Authorized Entities
may receive copies of or access to certain written technical support or explanatory documents
regarding eClinicalWorks' software; eClinicalWorks' services; and/or eClinicalWorks' internal
policies and procedures (collectively, "Documentation").

The examples, images, and scenarios presented in this documentation are solely for
explanatory use of the software and its functionality, and should not be construed as directives
for clinical or medical decisions; the user is ultimately and completely responsible for clinical
and/or medical decisions made regarding patient care.

eClinicalWorks documentation may contain hyperlinks to external sites and/or third-party
vendors for functional, informational, or instructional purposes. Use of these external links is at
the user's and licensee's risk.

eClinicalWorks assumes no responsibility for errors or omissions that may appear in this
publication and reserves the right to change this publication at any time without notice. All
users are instructed to consult the latest version of the Documentation at myeclinicalworks.com
for the latest updates to the Documentation at all times.

Once obtained, the distribution or posting this proprietary document on the Internet for public
and/or private use is strictly prohibited. This restriction includes Internet websites, forums,
blogs, private or public portals, or any other electronic means of sharing beyond the intended,
licensed user.
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APPENDIX B: Pl REPORTING PERIOD

Program Medicare EPs in | Medicaid EPsin | EPs Beyond their First
Year their First Year their First Year | Year of Reporting PI
2015 90 days 90 days 90 days
2016 90 days 90 days Full Calendar Year
2017 90 days 90 days Full Calendar Year
2018 and 90 days 90 days 90 days
future years

CEHRT
Program Year CEHRT
2015 2014 CEHRT (V10 of eClinicalWorks)
2016, 2017 2014 CEHRT (V10 of eClinicalWorks)
2018 2015 CEHRT (V11 of eClinicalWorks)
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APPENDIX C: NOTICES

Trademarks

A.D.AM.®

A.D.A.M. is a registered trademark of Ebix, Inc.
eClinicalWorks®

eClinicalWorks P2P®

healow™

eClinicalWorks, healow, and P2P are trademarks or registered trademarks of eClinicalWorks,
LLC. All other trademarks or service marks contained herein are the property of their respective
owners.

DigiCert®

DigiCert is a registered trademark of DigiCert, Inc.

2600 West Executive Parkway, Suite 500 Lehi Utah 84043

Elsevier®

Copyright © 2017 Elsevier, except certain content provided by third parties.
Healthwise®

Healthwise is a registered trademark of Healthwise, Incorporated.

Copyright

CPT Copyright Notice

CPT only © 2018 American Medical Association. All rights reserved.

Fee schedules, relative value units, conversion factors and/or related components are not
assigned by the AMA, are not part of CPT, and the AMA is not recommending their use. The
AMA does not directly or indirectly practice medicine or dispense medical services. The AMA
assumes no liability for data contained or not contained herein.

CPT® is a registered trademark of the American Medical Association.
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